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IColor ProRIP Software Introduction 
 

 
 

 

 

 

 

 

 

 

 

Use the IColor ProRIP software to print white as an overprint in one pass. This professional version is 
designed for higher volume printing with an all new interface. Design files can be printed directly from your 
favorite graphics program, as well as imported directly into IColor ProRIP. 

The IColor ProRIP software allows the user to control the spot white channel feature, as well as spot color 
overprinting, where white is needed as a top color for textiles. No need to create additional graphics with 
different color configurations – the software does it all – and in one pass. Enhance the brilliance of any 
graphic with white behind color. 

 

 

 

 

 

 

 

 

 

 

 

 

Print and Transfer onto: 
Natural and synthetic fabric (Light 
and Dark) 
Mugs and ceramics 
Light, dark and clear labels 
Leather 
Light and dark paper stock 
Glass 
Acrylic 
Wood 
Metal 
Window Cling 
Banners 
And much more! 
 

Create unique items – The 
possibilities are endless! 
T-shirts and sweatshirts 
Aprons 
Corporate logo shirts 
Mouse pads 
Sports apparel 
Jackets 
Tote bags 
Tattoos 
And much more! 
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The most important point of the IColor ProRIP software is that it allows colors to be put down in layers. Regular 
printer drivers only concern themselves with what the eye sees on the top layer, the RIP allows you to separately 
control each layer, thus giving you the ability to control not only what you see, but what is behind that top layer 
(typically the white layer). The IColor ProRIP gives you the unique ability to use one machine to print images with 
white as an underprint or an overprint. You can now print vibrant colors on clear or dark media regardless of the 
background to which it is applied, where the white is put down first and the colors afterwards.  

The IColor ProRIP ‘Color Mapping’ feature also allows for reverse printing when printing and transferring to 
garments where white is put down last. This is the only way to achieve white underprint and overprint in one pass, 
and you will not find another software/printer package on the market today that can do all of this. The software also 
allows for color manipulation and removal, rasterization, cost calculation, professional layout tools and direct printing 
from your favorite graphics program. It ships standard with all IColor Printers. 

To accomplish these two features, UniNet has created three configurations referred to as ‘Print Queues’ to suit any 
printing project. NOTE: THE ICOLOR 800W WILL ONLY HAVE THE OVERPRINT QUEUE FUNCTION. 

IColor 540/550/560 Cartridge Configuration 

 

IColor 500/600/650 Cartridge Configuration 
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The CMYK Queue is for standard print jobs that do not require a spot color. This queue assumes that the media 
being printed on is white. Use this Queue for printing on any white or light colored paper, banner media, window 
cling, Presto! Media and for Dye Sublimation prints. Note that for Dye Sublimation, there is an ICC Profile that can be 
used when this is selected. 

The Overprint Queue is for printing white as an overprint in one pass for reverse printing (typically used for transfer 
printing). For this configuration, the white and cyan cartridges are placed in the appropriate slot of your IColor 
printer. This configuration is for textile and hard surface transfer printing, where white is needed as an overprint, 
applied on top of all the other colors. When the image is pressed to the garment, the transfer sheet is flipped over 
and the white becomes the underprint. This is especially important where images have half tones and 100% transfer 
of the image can be problematic, or when there is white in the image that needs to show through on dark colored 
garments. 

The Underprint Queue is for right side printing and allows for printing white as an underprint in one pass (typically 
used for transparencies, clear labels, dark media or UniNet Aqua Clear paper). This is configured for ‘Right Side 
Printing’ where the white is printed first, as an underprint, all in one pass. In this situation, the RIP converts pure K 
colors to CMY composite black, and puts in white, not only as a background color, but also in the image where white 
or page white is specified.  

White toner performs the following functions: 

1) To produce the color white on a dark garment. 

2) To fill in the halftones on lighter images so that there is enough toner on the page to fully transfer to your 
garment or to pull all the B adhesive. 

 This second point is the most important one and the reason why you cannot simply use a CMYK printer for 
transfer printing. Also, this is why you MUST use the color white all the time (assuming your image has some 
halftones in it). Even when printing on a white garment and there is no white at all in your artwork. This is the 
biggest misconception with new users.  
 

  Don't make that mistake, always use the white toner cartridge for any type of transfer printing! 
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IColor ProRIP Software Installation 

 

 

 
 

 

 

 

 

 

 

 

• Make sure all other programs are closed and virus software is uninstalled. 

 Failure to uninstall virus software can lead to problems with installation and/or use of software. 

 If you keep the virus scan software active after installation, you must add the ProRIP to the ‘safe 
programs’ list or issues with ProRIP software can result. Windows Defender is the only program which, to 
date, has not affected the functionality of the ProRIP. 

• Plug in the included dongle into a free USB port on your PC. This dongle contains all of the software, manuals and 
documents for your printer and software and also serves are your license key. 

• Navigate to the RIP setup folder on the dongle and right click the setup file and select ‘Run as Administrator’. 
• Run the Installation and follow the steps pictured below. 
• NOTE: It is suggested to copy all of the installation files located on the USB drive to a folder on your computer for 

safe keeping and ease of installation. 
• The IColor ProRIP dongle must be inserted at all times when installing or running the program.  

 

1) Navigate to the RIP setup folder on the ProRIP dongle or 
on your PC if you’ve copied these files. Right click on the 
setup application file and ‘Run as administrator’.  
 

2) Select the language for installation and click ‘OK’.  
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3) You will be prompted to insert the USB dongle before proceeding with the installation. If already inserted, 
click ‘Next’. (There is only one dongle shipped with your system, and can look like either of the types 
represented below).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

IMPORTANT: This USB dongle is your license key. Ensure that it is not lost or broken, as UniNet cannot replace it 
without a charge. You cannot use the software without it installed in your PC.  

 
4) Select either the 32 or 64 bit application (dependent upon your version of windows). Accept the terms of the 

license agreement and click ‘Next’. 

 

5)  Choose ‘Full install of IColor ProRIP’ and click ‘Next’. Click ‘Next’ again to accept the installation folder. 
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6) Click ‘Next’ to allow the creating of the IColor ProRIP Program Folder and the installation will begin. 
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7) If not already installed, you will be prompted to install .NET Framework, which is a necessary component to 
the ProRIP software. Accept the license terms and click ‘Install’.  Once the InstallSheild Wizard is complete, 
click ‘Finish’. This installation normally takes several minutes to complete. 

  

   

 

ProRIP First Time Setup 
1) Be sure the IColor ProRIP dongle is installed and you are connected to the internet. From the Windows Start 

menu, choose All Programs >> IColor ProRIP or double click on the desktop icon that was created upon 
installation. Launch the program. Create a shortcut if desired for quicker access later. Confirm first time 
setup by setting your preferred unit of measure and decimal places. This can be changed later under Tools 
>> Options. 
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2) Once the ProRIP opens, the Queue Wizard will begin the installation of the support files for your IColor 
printer. Click ‘Next’ and then ‘Install Printer’. 

 

 
 

3) Select the appropriate printer from the support menu (in this case, we will choose the IColor 550). Click ‘OK’. 
Then click ‘Next’ to continue the installation. Note that you may have already installed the printer driver in 
windows. This installation is for RIP functionality only.  
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4) Click the ‘Port Setup’ dropdown and select how your printer is connect (Network or USB).   

 You must complete this step or you will not be able to print. 
 

5) If connected via network (recommended), choose TCP/IP. If connected by USB, choose the printer as 
identified in the drop down.  

 For USB connections, do not choose the port ‘Printer_USB-001+’. The proper port will also have the 
printer name in the description. 

 All other ports will update automatically, it is only necessary to do this for one queue. 

 

 

6) If connected via network, once TCP/IP is selected, the software will poll your network for available printers. 
Select the proper IColor printer. Note that the IP address of the printer is displayed.  

 Be sure to set a static IP address for your printer so that the IP address does not change later. If this 
happens, you will have to repeat this step. 
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7) If you need to change or reset the ports in the future: 
Click Queue >> Manage Queues to view, update or change the port settings.  

 Port settings will reset when the queues are updated so you will have to do this from time to time.  
 

 

8) In the ‘Port’ drop down menu, chose the proper port. If connected via network (recommended), choose 
TCP/IP. If connected by USB, choose the printer as identified in the drop down. All other ports will update 
automatically, it is only necessary to do this for one queue.  
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9) If connected via network, once TCP/IP is selected, the software will poll your network for available printers. 
Select the proper IColor printer. Note that the IP address of the printer is displayed. Be sure to set a static IP 
address for your printer so that the IP address does not change later. If this happens, you will have to repeat 
this step.  

 Consult your User Manual for steps on how to set a static IP for your model of printer. 

 

10) In order to print, select the proper Print Queue for your project. Then, select the Print Mode (otherwise 
known as media type) and verify the size of that media before importing your graphic.   
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11) Import the desired graphic by clicking the ‘green plus’ icon and navigating to the proper folder. You can also 
import by clicking File > Import File, or simply dragging and dropping your file into the queue. 

 

12) There are preloaded images that can used to print a test page. Click Devices >> Print Test Page to see the 
choices. It is suggested that you print a test page upon completion of the setup to confirm the printer has 
been properly installed. Use [Shift] and [Ctrl] to select multiple pages, and then click OK. More about the 
uses of each page can be found in the Help Topics file within the ProRIP program as well as the ProRIP User 
Manual. 
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Using the ProRIP Software (Summary) 
 

 

 

 

 

 

 

Once your image is loaded, take 
note of the preconfigured settings 
based relating to the media being 
used in the printer.  

The ‘Queue’ tab shows the size of 
the media that will be used, where 
to load the media into the printer 
and the paper type setting 
recommended.  

Each media type will contain this 
preconfigured data to make your 
printing experience as easy as 
possible. Overriding these settings 
could result in undesirable results.  

To alter the color settings, 
click on ‘Color Adjust’ and 
adjust as needed. ‘Coverage 
%’ represents the amount of 
white/clear toner overprint or 
underprint (depending on 
which queue is being used).  

The ‘Vary hole size in areas of 
transparency’ option allows 
for rasterization of colors that 
fade into nothing and to 
retain partial transparency. It 
is suggested that this option 
is left on, as it will only apply 
itself where it’s needed.  

Choke dictates how much the 
overprint white layer is pulled 
in under the colors. The 
higher the number, to more 
it’s pulled in (to avoid a white 
outline around your graphic). 
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•  You can also adjust the size of any image by dragging and dropping the corner of the image in the preview 
pane.  
 

• In this example, where we have a letter sized image placed on an A4 artboard, the red bar to the right of the 
image represents the portion of image that is outside the print margins. Be sure to resize to eliminate this 
bar before printing. 

  

 

The ‘Page’ tab offers the 
ability to print multiple 
copies and nest images. You 
can also adjust the size of 
the image to fit your media 
here (and in the Queue tab). 

The ‘Job’ tab allows you to 
lock the proportions of your 
image to maintain the aspect 
ratio. Here you can also 
mirror, rotate and invert the 
image.  You can also adjust 
the margins of the print if 
necessary.  

Note that the mirror function 
is automatically on for any 
image loaded into the 
overprint queue. 
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Adjustments can also be made by using these icons at the top of the screen. 

 

 

 

When ready, click the ‘Print’ icon to print your graphic. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 If you encounter any of these issues when printing from the RIP, please refer page 13, step 7 to set the 
proper port in Queue Manager. 

• Port Failed to open 
• Holding 
• Prompt to save rather than print 
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Once the print has completed, the job will be archived in the reserved area for 7 days. If you wish to reprint that job, 
drag and drop the job from the reserved section into the proper queue.  

 

 

 

 

 

 

 

 

 

 

 

 

 

To lengthen the amount of time a job stays in reserve, click Queue>>Properties. Then click ‘Job Reserve’ and set the 
‘Auto Clean Reserve’ time frame. Unclick to keep jobs in reserve forever.  
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After a particular job has printed, it will be ‘closed’. This means that it was rendered by the software so that the next 
time you print, the processing time will be minimal. If you need to make any changes to the print job before printing, 

you must ‘open’ the job. Otherwise, just reprint as needed (processing time is faster when already rendered).  
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Using the Cost Calculator 
The IColor ProRIP software has a cost calculation feature that enables you to estimate your printing costs prior to 
running the job. 

To set up to calculator for initial use: 

1) Click the cost calculator button at the top of the screen. 

 

2) A dialogue box will open. Input the cost and yield information as required.  
• In order to receive an accurate estimation, be sure to supply data for the Fuser, Transfer Belt, Waste Bottle, 

Toner and Drum.  
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3) You may also enter the cost for material, click charge, tax and time as desired. 
 

4) Click ‘Update’ to share these values with the other print queues 

 In the CMYK queue, be sure to change the price and yield from white to black 
 

5) Import your image.  
 

6) Right click on the image file, then click ‘RIP only’. This is required in order to proceed. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7) After the graphic is ripped, select the graphic file and click the calculator icon to see your printing costs. 
 

8) The ‘Total Cost’ at the bottom of the window is the per sheet printing cost estimate. 

 This cost includes the white underprint or overprint as well 
 

9) This data may be printed or exported to excel.  

 



 
23 
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Using the Rasterization Features 
Adding rasterization to a ‘closed’ design with no negative space increases the life of the garment by letting water 
and heat pass through more easily during each wash cycle, and allows for stretching of the garment and transfer 
without damage. It will also soften up the printed image and allow the garment to ‘breathe’ more naturally when 
worn. There are 2 ways to add rasterization effects to your image. 

Option 1: 

Rasterizing the entire image. Choose your media with either ‘holes’ or ‘stripes’ (also referred to as ‘dots’ or ‘lines’ in 
this document).  This option applies a uniform raster screen across the entire image and does not require any special 
setup in your original artwork. 

 

 

 

 

 

 

 

 

 

 

Graphical representation from the ProRIP with uniform holes: 
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Graphical representation from the ProRIP with uniform stripes: 

 

 

 

The size of the dots or stripes is adjusted in the ‘Easy Color Adjustments’ window by clicking ‘Color Adjust’ after 
your image is loaded, and is controlled by the ‘Dot Size’ slider. Sliding to the left makes the holes or lines bigger, and 
sliding to the right makes them smaller. A value of 255 is equivalent to ‘off’. UniNet suggests using the default 
parameter of 180 for best results. 

 

Option 2: 

By default, the ProRIP will automatically and variably rasterize portions of your graphic that fade out. Since there is 
no way for transfer media to do this on its own, the RIP will apply appropriate sized holes to your graphic in those 
areas that represent fades. Typically seen with images such as clouds, or smoke that, by their very nature, fade to 
nothing. The software looks for areas of transparency in the design and applies holes (small to large) across the 
design in the areas where there is a fading (transparent) effect. This effect won’t be seen until you either import an 
image that has some partial transparency or you import a raster image and then remove a color such as black, thus 
creating partial transparency. 
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The images below show what happens with variable rasterization after black is removed from the image. The image 
to the left is the original image file. The image to right is already pressed to a black shirt after the black elements are 
removed and automatic variable rasterization is applied.  

 

You may also want to rasterize certain parts of the image without removing a color. For example, if you are 
recreating a company logo with a large design behind it and only want to rasterize the background, but not the logo 
itself. To achieve this, you would create or modify the specific parts of image using partial transparency in your 
favorite art software. The more transparency the image has, the more rasterization the ProRIP will apply. Below is an 
example of an image with this type to rasterization applied. Since this is automatic and built in as a default option in 
the RIP, the user does not have to do anything except import and print. Notice that the logo shows full screening and 
the rest of the image is rasterized. Additionally, notice the outside border of the background shows increasing sized 
dots as it fades to nothing. 

 

 

Original graphic with 70% Opacity / 30% 
transparency applied to the background 
only: 
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Preview of how the graphic will print: 

 

 

 

 

 

 

 

 

 

 

 

  Zoomed in area variable rasterization:  
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Finished product pressed onto a 
black shirt: 

  

 

 

 

 

 

 

 

 

 

 

 

 

Zoomed in to show variable dot pattern: 

 

 

 

 

 

The size of the dots is controlled in the ‘Easy Color Adjustments’ window, when the ‘Use graphics transparency for 
dot size’ option is checked. The ‘Adjust Holes’ slider controls the size of the automatic variable rasterization based 
on object transparency. UniNet suggests using the default parameter of .70 for best results. Uncheck if you do not 
want automatic variable rasterization based on transparency. 
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It is also possible to 
combine effects by 
using both forced 
rasterization (option 
1) and automatic 
rasterization (option 
2). The RIP will force 
rasterization in areas 
where there is no 
partial transparency 
and will use variable 
dot sizes in areas that 
do. 

Adjusting the 
Frequency, Angle 
and Shape of Raster Lines or Dots - To alter the properties of the forced or variable holes or stripes in your image, 
click Queue > Properties > Color Layer > Ink Removal. With the ‘Enabled’ option checked, the Frequency, Angle and 
Shape may be adjusted freely.  

Ink Removal Settings 

Frequency - The halftone frequency is measured in Lines Per Inch (lpi), which indicates the resolution of the dot 
shape. This option will dither the lines or holes in the design.  

Angle - To avoid unexpected patterns from appearing in the final print, lines should be printed at specific angles. 
The choice of angles is quite subjective, though specific angles may be preferred according to the printing 
technology being used. The default angle of 52 avoids undesirable moiré patterns. 

Shape - There are a wide variety of shapes to choose for your halftone dots or lines. The choice of shape depends on 
what the user determines will produce good detail in your prints. For example, round and elliptical shapes are 
common, though test prints can determine whether other shapes are acceptable for the chosen artwork. 

Image preview with effects added 

To toggle between the original image and the image to be printed in the preview window, click these bird icons at 
the top of the preview window in the ProRIP. The bird icon on the right represents the original image. The bird on the 
left will preview how the image will look when printed. 
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To see a preview of the image in its entirety, right click the file in the print queue > RIP Only. Then right click the file 
again > View Raw Data. 

 

 

Note that the colors seen in this view are pure CMYK values – your colors will print accurately. 

 

 When printing an image that has portions where the substrate will show through, the Setup Color Boost 
feature will increase the amount of color ink being printed, so that the resulting colors will appear more 
vibrant. 

 

 Color boost is necessary because the amount of transparency information within the image is not 
optimized for the toner coverage and substrate being used. In other words, for the transparent areas of 
the printed image, the colors will generally be scaled back too much, which reduces their effectiveness. 
Color boost allows you to quickly correct for this. 

 

 For more information about color boost, refer to page 89.
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Basic Configuration  

The following sections provide short setup procedures for configuring IColor ProRIP. 

 
Switching Language 

 
 Tools menu >> Switch Language 

You can change the language of the program at any time within the tools menu. 

 

 
 

Creating a New Queue 
 
             Queue menu >> Manage Queues 

When creating queues, name each queue according to the type of jobs that will be collected within that queue. 
For example, name the queue according to the printer, and indicate the media/material that will be used. If 
queues have been assigned meaningful names, then designers will have greater ease when choosing which 
queue to send jobs to. Note that the print queues that come with the software are preconfigured for all basic 
uses of your printer. Follow the steps below to create custom queues.  

The procedure for creating a queue is as follows: 

1. Choose Queue menu >> Manage Queues. 

2. The Queue Manager will open. 
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3. Click the Add Queue button. 

 

4. The Create Queue Wizard will launch. 

5. Proceed through the wizard steps to choose the queue settings (i.e., choose the printer, port 
settings, print mode, page size, etc.). 

6. When the wizard is finished, the new queue will be listed in the Queue Manager dialog. 

7. Click Close to close the Queue Manager dialog. 

8. Below the menu and toolbar, the tab for the new queue will be available. 
 
Queue Menu 

The Queue menu contains the basic queue controls. 

• Manage Queues - Open the Queue Manager dialog, which is used to create queues for new printers, 
set the output port for the given device, and add printers to the Windows Control Panel. 

• Start - Same as the Start Queue toolbar button. Start the current queue and process each print job 
according to the queue properties. 

• Stop - Same as Stop Queue toolbar button. Hold all jobs in queue, regardless of the queue scheduling 
settings. 

• Clear Job Errors - If a problem occurs when printing (such as paper out), the print job will be put on 
hold. After the printing problem is resolved, use the Clear Errors item to remove the error flag. 

If a job has encountered an error condition, then the job properties will summarize the errors. The job 
properties also include a detailed Log of the tasks that were completed before the error was 
encountered (see the Log tab). 

• Queue Menu Wizards - These wizards are designed to help you quickly determine what print settings 
should be used for a specific garment material. 

• Properties - Open the Queue Properties dialog. 

 

mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/Creating_a_New_Queue_VPM10.htm
mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/Adding_a_Queue_to_the_Windows_Control_Panel_VPM10.htm
mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/Starting_and_Stopping_Jobs_v10.htm
mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/LogTab_DFA_v10.htm
mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/Queue_Menu_Wizards.htm
mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/Queue_Properties_DFA_v10.htm
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Queue Menu Wizards 
 

For your shop, it is normally quite difficult, costly, and time consuming to determine the absolute best print 
quality   settings for your DTG printer. Ideally, you need your printing software to work perfectly out-of-
the-box, except that there are so many variables to the process, from the type of garment material, the 
garment color, the method of pretreatment,  the graphic type, and the operating environment (i.e., 
humidity). 

Even when using the highest quality garment materials, many tests are required, including for each 
garment color. These tests are especially important for light-colored shirts, which are the most difficult in 
terms of obtaining good quality prints. 

In order to perform your garment tests efficiently, use the Queue Menu wizards, which are each designed to 
quickly print test charts for you to determine the correct print settings. The queue properties will then be 
set automatically, so that all subsequent jobs will be top quality. 

 
Creating Custom Queues 

 
When support files are installed for your printer, groups of default queues come preconfigured for color, 

black, and white garments. Each group typically contains queues that are configured for jobs that are 
primarily composed of photographic images (Photos), versus queues that are for jobs composed of vector 
graphics and logos (Graphics). 

However, these are not all-purpose queues that will satisfy every aspect of what is a complex printing process. 
These preconfigured queues are starting points, which you can duplicate for different substrate colors, 
including substrates from different manufacturers. 

For example, suppose that you have received new supplies of T-shirts from Apex textiles (an imaginary 
manufacturer of garment materials). You chose Apex as your supplier because they provided an 
attractive discount with the volume purchase of shirts, and you ordered colors like Hot Pink, Banana 
Yellow, Army Gray, and so on. 

To organize your queues, you would create a new group like "Apex Photo," under which you would create 
duplicates of the default "Photo" queue, and rename each duplicate according to the garment color that 
it represents. The following diagram illustrates how your default queues might look after customization. 
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Likewise, you would create an "Apex Graphics" group, and populate it with duplicates of the default 
"Graphics" queue, again renaming each duplicate according to your garment colors. 

When your duplicate queues are all in place, the Queue Menu Wizards can then be performed for each 
garment color, and your testing will refine each queue to obtain the quality prints that you need. 

Note: Though our examples have focused on color garment materials, you should also feel 
encouraged to customize queues for your white and black garments, especially in cases 
where you have chosen a new garment manufacturer. 

 
 

Duplicating a Queue 
 

When a new printer is installed, the preconfigured queue tabs will have common settings for you to use as a 
starting point. Preconfigured settings will need to be refined according to your job types (e.g., photographic 
prints, graphic designs, etc.), an production environment  

In particular, for different substrate colors (and especially for substrates from different manufacturers), you 
want to duplicate preconfigured queue, and then customize that duplicate according to the substrate. 

For example, suppose that you have pink substrate material, and you have a preconfigured queue for "color" 
substrates. 

 

1. Choose Queue menu >> Manage Queues. 
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2. Select the "color" preconfigured queue, and then click the Copy Queue button. 

 

3. The new queue will be appended to the list. 

4. With the new queue selected, click [...] to open the Queue Properties dialog. 

 
5. In the Queue Properties dialog, change the queue name according to the substrate color. 
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6. Click OK to close the Queue Properties dialog. 
7. Click Close on the Queue Manager dialog. 

 

Your new queue will now have its own tab in IColor ProRIP, and you can refine its settings using the Queue 
Menu Wizards. 
 

Viewing Hidden Queues 

Queue tabs are arranged left-to-right. When there are more queue tabs that can fit within the display, two 
scroll buttons (on the right) can be used to browse hidden tabs. 

 

 
 

Rearrange Queue Tabs 

Queue tabs are arranged left-to-right in the order that each queue was created. To rearrange the tabs, use 
the Queue Manager dialog. 

 

1. Choose Queue menu >> Manage Queues. 

2. The Queue Manager will list the queues tab names. 

3. Click the queue that you want to rearrange. 

4. Along the dialog toolbar, there are four buttons for moving the selected queue up/down in the list. 
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Adjusting the Queue Properties 
 

IColor ProRIP provides several predefined queues with suggested settings for each type of garment material. 

 

1. Select the queue by clicking its tab. 

2. To edit the queue properties, click the Configure 

Queue button. Alternatively, choose Queue menu 

>> Properties. Alternatively, double-click the queue 

tab. 

3. The Queue Properties dialog will open. 

4. Along the left-hand side of the Queue Properties dialog, click the category of settings that need to be 
adjusted. This is where you would adjust the substrate color preview.  

 
Inspecting Job Properties 

 
When a job is received in a given queue, the properties of that job are "inherited" from the queue 

properties. For example, a received print job will use the print mode that had been previously set for that 
queue. 

In most cases, there is neither a need to inspect nor modify the job properties. However, in the event of an 
unexpected device error, then the error log can be inspected within the job properties. 

1. Suppose that a job error has occurred, and the job is being held in the 

active list. Alternatively, clicking the Stop Queue button will cause new 

jobs to be held pending. 

2. Right-click the job and choose Properties. 
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3. In the Job Ticket Properties dialog, choose Other >> Log tab. 
 
Understanding the ProRIP controls 

When a print job is received, it will be acted upon according to the properties of the given queue. 
Commonly, a queue is set to act upon a print job, which will cause the job to appear in the Active List, 
and its layout previewed in the Visual Print Manager. If a print job is not scheduled, then it will be listed 
in the Reserved List (i.e., the job is set aside until the user chooses to schedule the job). 

 

A - Along the top is the toolbar that provides some top-level controls for the selected queue and/or job. 

B - Below the toolbar are the preconfigured queue tabs, which provide default settings for your printer. 
Note: To optimize the queue tabs for your shop, please refer to the Queue Menu Wizards.
  

C - Each queue is a repository for collecting and managing print jobs. 

D - Below the queue jobs is the Reserved List, which collects jobs that have been completed. 

E - The Layout Preview shows the layout of jobs upon the media/substrate. 

F - Below the Layout Preview is the SmartBar, which provides context-sensitive controls that vary 
according to whether the Queue, Page, or Job are selected. 
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Starting and Stopping Jobs 
 

For a given queue, if the Start Queue button has been clicked, then jobs will proceed according to 
the schedule settings as set within the queue properties. 

If the Stop Queue button has been clicked, then all jobs will be placed on hold, regardless of the 
schedule settings within the queue. 

 

 
 

To adjust the schedule settings of the queue, choose Queue menu >> Properties >> Layout 

Manager tab.  If a print job is being held in the active list, then it can be printed by right-clicking 

the job and choosing Print. 

 
Cancelling a Print Job 

 
Should it be necessary to suddenly stop a job, use the following steps to cancel the job in a clean fashion, 

such that you can get started with the next job promptly: 

1. Pause the job on the printer control panel. 

2. In IColor ProRIP, right-click the job and choose Abort. 

3. Windows will open a Port Locked dialog. Do not close this dialog. 

4. From the printer control panel, reset the printer. If there is no reset button (or procedure for 
resetting the printer), then turn the printer OFF. After powering OFF, power the printer ON after 
a short pause. 

5. Return to the Port Locked dialog and click OK to continue. 
 

At this point, the printer should be ready to process new jobs, and buffer data from the cancelled job will 
have been cleared. 
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Toolbar Controls 
 

The Toolbar provides high-level queue management, such as starting and stopping the queue, clearing 
errors, and deleting jobs. 

• Open - Open a browse dialog and choose an image file to print. The given file (e.g., EPS, BMP, TIFF, 
etc.) will be added as a job in the current queue. 

• Remove Job - Permanently delete the selected job(s). 
• Release Job - Release a held job for printing. 
• Hold Job - Stop the job, regardless of whether the queue is stopped. 
• Spool Job - Spool the print data without sending to printer. The spool file is retained on the hard drive, 

which can be previewed by right-clicking the job and choosing View Raw Data. 
• Print Job - Begin printing the job (i.e., spool the job and send the print data to the printer). 
• Archive to Disk - Store the job in an archive location, such that it can be restored at a later date. 
• Center on Page - Center the job horizontally and vertically on the material. 
• Center Horizontally on Page - Center the job horizontally on the material. 
• Fit to Page Width - Scale the job to match the page width. 
• Fit to Page Height - Scale the job to match the page height. 
• Fit to Page - Scale the job without exceeding the page size. 
• Clear Errors - If a problem occurs when printing (such as paper out), the print job will be put on hold. 

After the printing problem is resolved, use the Clear Errors item to remove the error flag. 

If a job has encountered an error condition, then the job properties will summarize the errors. The job 
properties also include a detailed Log of the tasks that were completed before the error was 
encountered (see the Log tab). 

• Abort Jobs - Cease further processing of the job. 
• Start Queue - For the current queue, process jobs as they are received, per the queue properties. 
• Stop Queue - Hold all jobs in queue, regardless of the queue scheduling settings. 
• Configure Queue - Open the Queue Properties dialog for the given queue. 
• Printer Status and Settings - Query the printer for its current panel settings. 
• Costing - Open the Queue Properties dialog to the Costing tab. 
• Find Job - Select and output a job by scanning the barcode for that job. See Barcode Support 
• Job Color Replacement - Perform substitutions of either specific colors or color ranges. 

 

 

mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/CostingTab_DFA_v10.htm
mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/BarcodeSupport_v10.htm
mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/Job_Color_Replacement.htm
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The Main Menu 
 

• The File menu provides tools for importing images directly into a queue, rather than from a graphic 
design application. The imported image can be from either an image file (e.g., BMP, JPEG, etc.), or a 
desktop scanner. 

• The Queue menu provides controls for creating and adjusting queue parameters. 
• The Jobs menu provides controls for adjusting selected jobs. 
• The Devices menu provides tools for installing printers, customizing print mode settings, and printing 

test pages to confirm quality. 
• The Tools menu provides controls for adjusting the interface and system preferences. 

 
File Menu 

The File menu provides tools for loading images into a given queue for printing. 

• Import File - Open a browse dialog and choose an image file to print. The given file (e.g., EPS, BMP, 
TIFF, etc.) will be added as a job in the current queue. 

• Find Files - Open a search dialog to locate a specific image file. Search criteria includes location, 
filename, file type, and modification date. 

• Get from Gmail - Use a Google email account to receive job files, which can then be loaded into iColor 
ProRIP. 

 Get from Gmail 

You can configure iColor ProRIP to periodically scan for jobs that have been sent via a Google email account. 
This is a convenient means of transferring images from digital phones, and tablets. 

●      For an image file that is attached to the gmail message, it will be added to the queue. 

●      If the Subject line of the message matches (exactly) the name of a queue, then the image file will be 
added to that queue. 

●      Otherwise, the image file will be added to the most recent queue. 

 

 

 

 

 

mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/File_Menu_v10.htm
mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/Queue_Menu_v10.htm
mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/Jobs_Menu_v10.htm
mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/Devices_Menu_v10.htm
mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/Tools_Menu_v10.htm
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Choosing the Port Settings 
 

1. From the Queue menu, choose Manage Queues. 

2. The Queue Manager dialog will open. 

3. For the given device, the Port column indicates the output port. 

4. Choose a port from the drop-list. 

5. Once a port has been selected, its properties can be adjusted by clicking [...]. 
 
 

USB Port 
 

A Universal Serial Bus (USB) port has the benefit of allowing new hardware to be added without 
configuration concerns or hardware conflicts. In addition, a USB device may be added without requiring 
the workstation to be restarted. 

1. When a printer is connected to the computer via its USB port, Windows will automatically detect the 
USB printer. 

2. In IColor ProRIP, the USB port name for the printer should now be available. 

3. From the Queue menu, choose Manage Queues. 

4. The Queue Manager dialog will open. 

5. From the Port column drop-list, choose the USB port that is named specifically for your printer model. 

 
Example: For our Acme Printer, the USB port will be listed as "Acme Printer 
Pro_USB00X+port name." 

 
Note: Depending upon advanced settings within IColor ProRIP, it is possible that there is a 
secondary "USB00X" port (or "LPTUSB1" in the case of Belkin Adapters) that is available. Do 
not choose either of these secondary ports, unless requested to do so by Tech Support. 

Note: Though USB is considered to be quite fast, consider that USB is a bus-based 
system that can be slowed significantly by other USB devices that are connected to the 
same bus (i.e., same workstation). For example, if an external USB hard drive or flash 
drive is connected to the workstation, then this can incur performance and time out 
issues. 

Note: Most computers that have numerous USB ports, in actuality there are (perhaps) only 
one or two USB buses internally. Check the workstation specifications (i.e., motherboard) to 
determine how data is managed by the workstation. 
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TCP/IP Port 
 

The TCP/IP port is used with printers that are accessed across a TCP/IP network. In order to use a 
TCP/IP network printer, your network system administrator should be consulted to determine the IP 
Address, Protocol, and Port number of the printer. 

 
Note: To install TCP/IP protocol under Windows, please refer to Windows Help. 

 

 
 
 
Installing a New Printer 

 
Devices menu >> Manage Devices 

When creating a new queue, you will be provided with the opportunity to install a given printer or cutter. 
However, to install a printer without creating a queue, use the following procedure. This procedure is 
typically for modifying an existing queue to use a new device. 

1. Choose Devices menu >> Manage Devices. 

2. The Manage Devices dialog will list the currently installed printers. 

3. In the Manager Printers dialog, click the Add Printer button. 
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4. Choose from the list of available printers, and then click OK to proceed. 

5. The Device Package Search page will query for the location from which support files will be installed. 

6. Click the option "Search for new device package versions from a CD and/or the Internet" 

7. Clear the "Search CD-ROM or floppy drive" checkbox. 

8. Tick the "Search dedicated Online server for updated device packages" checkbox. 

9. Click Next to proceed with the installation. 

10. The new printer/cutter will now be listed within the Manage Devices dialog. 

11. Click Close. 
 

Once a printer has been installed, it can be assigned to an existing queue, or a new queue can be created. 

Updating Drivers and Support Files 
 

Devices menu >> Manage Devices
  

 
Note: For computers that are not connected to the Internet, it is assumed that you have 
manually obtained the desired drivers and support files, and have placed them in a directory 
that the computer can access. 

Use the following procedure to update machine drivers and support files that will be used by IColor ProRIP. 

1. Choose Devices menu >> Manage Devices. 

2. The Manage Devices dialog will list the currently installed printers and/or cutters. 

3. Click the Check for Online Updates button, and available files will be sought from the CADlink web site. 

Alternatively, if you have placed the drivers and support files locally (e.g., on the hard drive or CD-
ROM), then click the Check for Local Updates button. In this case, you will be prompted for the 
location of the files. 
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4. When file updates are located, click the Update Devices button to proceed. 

5. When the updates are complete, click Close. 

 
Assigning a Different Printer 

After you have been using IColor ProRIP for a while, there will come a time when the printer needs to be 
replaced. Instead of creating a new queue, the following procedure can be used to assign a new printer to 
the queue: 

1. Choose Devices menu >> Manage Devices to install a new printer. 

2. Choose Queue menu >> Manage Queues. 

3. The Queue Manager dialog will list the existing queues. 

4. For the desired queue, set the printer. 

5. Optionally in the Control Panel column, click Install to add the printer to the Windows Control Panel. 

This allows other Windows applications to File menu >> Print to that printer, and those print jobs will 
be received by IColor ProRIP. 



 
46 

 

Sending Jobs to IColor ProRIP 

Once you have installed IColor ProRIP , each of the following workflows is designed to help you confirm 
that print jobs are being received and processed by IColor ProRIP correctly. Choose the workflow that 
best represents the method by which you will use IColor ProRIP . 

 
Sending Jobs from SignLab® 

For the latest versions of SignLab, there is support for printing directly to IColor ProRIP: 

● File menu >> Print and Cut - Print to IColor ProRIP without generating an underbase. This is 
suitable for printing to white garment material. 

● File menu >> Print with Underbase - Automatically generate underbase information for printing to 
either black or color garment material. 

 

For older SignLab versions, use the following procedure to add the queue as a print destination within the 
Windows Control Panel. Printing from SignLab will use the common Windows File menu >> Print 
command. 

Note: Using the Windows Control Panel does not permit alpha (transparency) channel data, 
which prevents you from defining a white underbase for printing to black or color garment 
material. 

 

In IColor ProRIP 
 

1. Choose Queue menu >> Manage Queues. 

2. In the Control Panel column, click the Install button, such that the queue is available as a print 
destination for other Windows applications. 

3. Click the Close button. 
 
 

In SignLab 
 

4. Prepare the print design on the SignLab workspace. 

5. Save the design file, such that the design is not “untitled.” 

6. Choose File menu >> Print to open the Print dialog. 

7. From the Printer tab, choose the queue that had been designated in step (2). 

8. Click OK to accept the Print dialog settings, and the job will be received in IColor ProRIP . 
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Sending Jobs from PhotoShop® 

When IColor ProRIP was installed, additional Send to IColor ProRIP plug-ins were installed for your 
PhotoShop. These plug-ins provide a quick means of transferring your PhotoShop design to IColor ProRIP 
in a manner that prepares the design for garment printing. 

● File menu >> Automate >> Send to IColor ProRIP - Print to IColor ProRIP without generating an 
underbase. This is suitable for printing to white garment material. 

● File menu >> Automate >> Send to IColor ProRIP with Underbase - Automatically generate 
underbase information for printing to either black or color garment material. 

 
 

In PhotoShop 
 

1. Prepare the print design in PhotoShop. 

2. Save the PSD file, such that the design is not “untitled.” 

3. Choose File menu >> Automate >> Send to IColor ProRIP. 

Alternatively, choose Send to IColor ProRIP with Underbase when printing to black or color 
garment material. 

 
4. In the Send to IColor ProRIP dialog, choose the queue name and click OK. 

To send jobs to IColor ProRIP that is installed on a remote computer, click Browse and choose the 
network location. 

 
5. The job will be received in IColor ProRIP. 

 
 
 

Sending Jobs from Illustrator® 

When IColor ProRIP was installed, additional Send to IColor ProRIP plug-ins were installed for your 
Illustrator. These plug-ins provide a quick means of transferring your Illustrator design to IColor ProRIP in a 
manner that prepares the design for garment printing. 

● File menu >> IColor ProRIP >> Send to... - Print to IColor ProRIP without generating an 
underbase. This is suitable for printing to white garment material. 

● File menu >> IColor ProRIP >> Send with Underbase... - Automatically generate underbase 
information for printing to either black or color garment material. 

 
 

In Illustrator 
 

1. Prepare the print design in Illustrator. 

2. Save the design file, such that the design is not “untitled.” 
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3. Choose File menu >> Send to IColor ProRIP. 

If the design is being prepared for printing to a black or color garment material, then click Send 
to IColor ProRIP with Underbase. 

 
4. In the Send to IColor ProRIP dialog, choose the queue name and click OK. 

To send jobs to IColor ProRIP that is installed on a remote computer, click Browse and choose the 
network location. 

 
5. The job will be received in IColor ProRIP. 

 
 
 

Sending Jobs from CorelDraw® 

When IColor ProRIP was installed, additional Send to IColor ProRIP plug-ins were installed for your 
CorelDraw. These plug-ins provide a quick means of transferring your CorelDraw design to IColor ProRIP 
in a manner that prepares the design for garment printing. 

● Standard toolbar >> Send to IColor ProRIP - Print to IColor ProRIP without generating an 
underbase. This is suitable for printing to white garment material. 

● Standard toolbar >> Send to IColor ProRIP with Underbase - Automatically generate underbase 
information for printing to either black or color garment material. 

 
 

In CorelDraw 
 

1. Prepare the print design in CorelDraw. 

2. Save the design file, such that the design is not “untitled.” 

3. From the Standard toolbar, click the Send to IColor ProRIP button. 

If the design is being prepared for printing to a black or color garment material, then click Send 
to IColor ProRIP with Underbase. 

 

 
 

 
4. In the Send to IColor ProRIP dialog, choose the queue name and click OK. 
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To send jobs to IColor ProRIP that is installed on a remote computer, click Browse and choose the 
network location. 

 
5. The job will be received in IColor ProRIP. 

 
Importing Designs Directly into IColor ProRIP 

Design files can be imported directly into IColor ProRIP , without the need to open the files in their original 
design applications. Use this workflow where you have a design file that must be printed without having 
access to the original design application. For example, the customer has sent you a design file, and you 
need to print the file “as is” without importing it into a design application. 

 

Note: The supported image formats are subject to change, though common image formats 
are supported (e.g., EPS, AI, PDF, BMP, JPEG, TIFF, etc.). For designs that contain an alpha 
(transparency) channel, the image format should be either PSD, PNG or TIFF. 

 

In the Design Application 
 

1. Prepare the print design. 

2. Save the design file. 
 

In IColor ProRIP 
 

3. Load the design file using one of the following methods: 

a) Choose File menu >> Import File. 

b) From the toolbar, click the Open button. 

c) Drag-and-drop the file into the IColor ProRIP window. 

d) Choose File menu >> Get from gmail to configure IColor ProRIP to receive designs via a 
Google email account. 

 

4. The job will be received in IColor ProRIP. 
 
Sending Jobs Using a Hot Folder 

This workflow uses a specially designated Hot  Folder (i.e., a directory on the hard drive). When design files 
are copied into the Hot Folder, they will be automatically detected by IColor ProRIP and processed. Note 
that the copied file will be subsequently deleted by IColor ProRIP. 

 
 

Create an Empty Hot Folder 
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1. Create an empty directory on your IColor ProRIP computer, or elsewhere on your network. 
This will be your Hot Folder, which must satisfy the following two conditions: 

a) The IColor ProRIP computer must have login permission to read and write to the Hot Folder. 

b) Your graphic designers must have file access permissions to write/copy files into the Hot 
Folder. 

 
 
 

In IColor ProRIP 
 

2. Choose Queue menu >> Properties. 

3. Click the Hot Folders tab. 

4. Tick the Enable queue hot folder checkbox, which opens a browse dialog. 

5. Browse to the Hot Folder that had been designated in step (1). Please note that the Hot Folder 
must be empty when it is initially chosen. 

6. Click OK to accept the Hot Folder path. 

7. Click OK to close the Queue Properties dialog. 
 
 

In the Design Application 
 

8. In the design application, prepare the print design. 

9. Save the design file in a commonly accepted format (e.g., EPS, AI, PDF, BMP, JPEG, TIFF, etc.), and 
copy the design file into the Hot Folder. 

For designs that contain an alpha (transparency) channel, the image format should be either 
PSD, PNG or TIFF. 

10. The job will be received in IColor ProRIP. 
 
Image Manipulation Topics 

For a job that is being held in a queue, the Jobs menu provides an assortment of image manipulation tools. 
 

Image Manipulation Using GIMP 

GIMP is a third-party image manipulation tool that is suitable for a variety of image manipulation tasks, 
including photo retouching, image composition, and image construction. The following sections contain 
procedures for performing basic operations using GIMP, which you should complete in order to gain a 
sufficient understanding of these tools. Once you have developed a familiarity with the GIMP tools, you 
will be ready to consult the exhaustive help resources that are available through the GIMP web site. 

Due to the collaborative nature of the GIMP project, CADlink neither maintains nor provides support for 
technical issues related to GIMP. Instead, the answers to technical questions should sought through the 
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GIMP web site, where concise answers for your design needs can be addressed. 
Note: Help files for GIMP are available from the http://docs.gimp.org site. Both tutorials and 
forum support are available   from the www.gimp.org site. 

Please refer to the Help Topics file within the ProRIP program for further information regarding GIMP. 

Topics include: 

Launching GIMP 
 
 Opening Dialog Controls 
 
 Adding Tab Controls 
 
 Dragging Tabs 
 
 Saving an Image Back to the Queue 
 
 Moving a Selection 
 
 Apply Effects to Portions of an Image 
 
 Draw a Straight Line 
 
 Apply Stroke to a Selection 
 
 Create a Complex Selection Using Quick Mask 
 
 Saving Images with Transparency 
 
 Making a Selection Partially Opaque 
 
 GIMP Tutorial - Simple Floating Logo 
 

 
 
Fluid Mask - Easy Image Clipping 

 

Note: Fluid Mask also has its own help documentation, and tutorial videos are available from 
the Fluid Mask web site ( www.vertustech.com ). 

Fluid Mask is an intuitive tool for knocking out the background of an image, such as a photo of a person 
standing before scenery. The process is very much like a paint-by-numbers coloring book, where you paint 
with a green brush (the Keep brush) to indicate the foreground, and paint with a red brush (the Delete 
brush) to indicate background. 

 

http://docs.gimp.org/
http://www.gimp.org/
http://www.vertustech.com/
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Suppose that you have a customer photo, such as a JPEG image of their child that was taken using a digital 
camera. However, the background of the image is cluttered and needs to be clipped using Fluid Mask. 

 
Please refer to the Help Topics file within the ProRIP program for further information regarding Fluid Mask 

Super Size Image 
 

Jobs menu >> Super Size Image 

The Super Size Image is an image enlargement tool that increases the resolution of an image, whilst 
retaining the detail and qualities of the original image. Typically, it would be desirable to increase the 
resolution for images that are lower resolution than ideal, or after scaling the job to print at dimensions 
that are much greater than the image was designed for. 

 

For example, suppose that a job image has a resolution of 150 dpi, and you have used the Visual Print 
Manager to scale   the image print dimensions by 100%. However, scaling did not change the image 
resolution. As a solution, use Super Size Image to increase the image resolution. 

1. Select the job and choose Jobs menu >> Super Size Image 

2. The current image resolution will be displayed, and you are provided an opportunity to set a 
higher resolution. 

3. When the OK button is clicked, the Zoom Engine dialog will preview the quality of the resized 
image. Adjust the Zoom Engine controls to retain the desired quality. 

 

Preview Image – A thumbnail of the original image is shown in the upper-left corner of the dialog, and a 
zoomed preview takes up about 2/3 of the right-hand side. Click the original image thumbnail to center 
the preview. 

Zoom Level –Click the (+) and (-) buttons to adjust the zoom level of the zoomed preview. 

Super Size V1 and V2 – These are versions 1 and 2 of the Super Size algorithm that is used for enlarging 
images. Super Size V2 is the improved method that retains greater image quality (e.g., less aliasing, 
sharper details, etc.), though the V1 method remains available as an alternative. 
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Edges Crispness – This slider varies in the range of [-100, 100]. Positive values will sharpen the edges 
between color regions, whereas negative values will blur the edges. 

Surface Smoothness – This slider varies in the range of [0, 100]. This slider affects the perceived 
texture of the image. Low slider values allow the image to appear more jagged (i.e., rough), 
whereas high values create the impression of a continuous, smooth surface. 

Soft and Chroma – Note that the Soft and Chroma options are only available if Super Size V2 is 
enabled. Tick the Soft checkbox to create a slight blur that suggests softness within the image. 
Tick the Chroma checkbox to increase the color saturation. 

Brightness (-100, 100) – Adjust the intensity of the finished image. 

Contrast (-100, 100) – Adjust the perceived difference between light and dark regions of the image. 
KnockMeBlackOut 

 
Jobs menu >> Production Plug-ins >> KnockMeBlackOut 

The KnockMeBlackOut command is optimized for creating an underbase for either a black or near-black 
garment color. If you have an image that already has a black background, and you want to print onto a 
black shirt, this plug-in effectively provides a one-hit sequence for preparing the image. Use of this feature 
requires Bitmap graphic formats such as BMP, PSD, PNG, TIF, JPEG. PDF and EPS files will not work with this 
feature. 

1. Choose the KnockMeBlackOut command, and the preview dialog will show two versions of the image. 
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2. By adjusting the Underbase and Midtones slider, this allows you to vary the shades of gray that 

will be "knocked out" of the image. Underbase of 74 and Midtones between 2.5 & 3.5 are 
suggested. 

 
The KnockMeBlackOut Controls 

Preview- The original image is shown above the filtered image. At the bottom-right is a zoom 
control for inspecting the filter results. When the zoomed image does not fit within the available 
space, click and drag to reposition the preview. 

Transparent - This is a preview mode that shows how the image will appear once the plug-in is 
applied. This is the best view for inspecting the image colors that will be printed. 

All transparent areas are denoted by a "checkerboard" pattern where the garment color will show 
through. The fainter the checkerboard pattern, the more underbase that will be printed. 

 

The top image will show the original appearance, and the bottom image will show the result 
generated by the KnockMeBlackOut plug-in. 
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Show Underbase- This preview mode shows the white underbase that will be created. 

Note that the preview is inverted, such that black areas represents the white underbase, and the 
white areas will be applied with underbase. 

Gray areas will represent a thin underbase layer will be printed to allow some of the garment color to 
show through 

 

 

 

 

 

Original Image 

Before using KnockMeBlackOut, we setup our 
original image with the following: 

1. A solid blue strip 
2. A yellow-to-black gradient fade 
3. A spot white-to-black gradient fade (i.e., a 

white ink is part of this gradient) 
4. The word "WHITE" (with white text color) 
5. The word "BLACK" (with black text color) 

 

Transparent Mode (checker pattern = garment 
color) 

In the KnockMeBlackOut preview, the Transparent 
option will use a checker pattern where nothing is 
printed. For our original image, the preview shows: 

1. The solid blue that will be printed. 
2. The yellow color that gradually blends to 

the garment color. 
3. The printed spot white that gradually blends 

to the garment color. 
4. The print spot white of the word "WHITE" 

For the word "BLACK," no ink is printed. 
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Shirt Color - This preview mode combines the garment color, underbase and image colors to show the 

preview as it would appear on the finished garment. The color picker can be used to choose the 
specific hue that represents the garment color. 

 
 
 
 
 
 

Show Underbase Mode (black = applied underbase) 

The Show Underbase option uses black to 
represent the printed white underbase, and a 
checker pattern where nothing is printed. 

1. Solid black that represents solid white 
underbase. The solid blue color will be 
printed atop the underbase. 

2. A black strip that fades to gray. The 
underbase is strongest at the left, where the 
yellow needs dominate the garment color. 

3. A black strip that fades to gray at the far-
right. Again, the The underbase needs to be 
strongest at the left, where the white needs 
to dominate the garment color. 

4. The word "WHITE" appears black, since a 
solid white underbase will be applied here. 

5. The word "BLACK" appears white, since zero 
underbase will be applied. 

Of course, printing black ink on a black garment in 
point (5) does not make sense, and is only used 
here as an example. 
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Underbase - Use this field to adjust the underbase strength (0..255) that will be applied to the 

garment. The default underbase setting is 70 (about 25% of maximum). 

Increasing this value will cause more underbase to be laid down, which will increase the perceived 
color brightness in the printed image. 

Shirt Color Mode  

(show garment color mixed with image) 

The Shirt Color option shows the image colors as 
they will appear when printed on the garment, 
and a checker pattern where nothing is printed. 

1. A solid blue strip. The white underbase has 
been applied, and only blue should be 
visible on top. 

2. A yellow-to-black gradient fade. Inspection 
of the garment will show that less yellow is 
printed as the gradient blends into the 
black garment color. 

3. A spot white-to-black gradient fade. 
Inspection of the garment will show that 
less white is printed as the gradient blends 
into the black garment color. 

4. The word “WHITE” should appear as a solid 
white. 

5. The word “BLACK” will preview as black 
because it matches the black garment 
material. 

Of course, printing black ink on a black garment in 
point (5) does not make sense, and is only used 
here as an example. 
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Reset - Set all the dialog controls to their recommended defaults. 

 
Note: Changing the underbase setting does not change areas that will have 100% white ink in 
the underbase, nor area that require no white ink in the underbase. Instead, the underbase 
setting will change the amount of white ink used to blend the black garment color into the 
image colors (i.e., in the shadow regions of the image). In effect, increasing the underbase 
can cause shadow regions of the original image to appear lighter and more visible. 
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KnockMeColorOut 
 

Jobs menu >> Production Plug-ins >> KnockMeColorOut 

This KnockMeColorOut command is optimized for creating an underbase for a specific garment color. 
However, if the garment color is black or near-black, then please refer to the KnockMeBlackOut plug-in. 
Use of this feature requires Bitmap graphic formats such as BMP, PSD, PNG, TIF, JPEG. PDF and EPS files will 
not work with this feature. 

1. Open or create the design that will be printed. 
Note: In PhotoShop, the KnockMeColorOut plug-in does not work with images on the default 

Background layer. If the image is on the default Background layer, then you must create a duplicate 
of the image on a new layer, and then delete the old Background layer. 

2. Choose the KnockMeColorOut command, and the preview dialog will show two versions of the image. 
 
 

 

 
 

3. By adjusting the Underbase slider, this allows you to vary the hues of the selected color that will be 
"knocked out" of the image. 

 
 
 
 
 
 

The top image will show the original appearance, and the bottom image will 
show the result generated by the KnockMeColorOut plug-in. 
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The KnockMeColorOut Controls 

Preview- The original image is shown above the filtered image. At the bottom-right is a zoom control for 
inspecting t the zoomed image does not fit within the available space, click and drag to reposition the 
preview. 

Transparent - This is a preview mode that shows how the image will appear once the plug-in is applied. 
This is the b the image colors that will be printed. 

All transparent areas are denoted by a "checkerboard" pattern where the garment color will show 
through. The fainter pattern, the more underbase that will be printed. 

 

 

 

 

 

Original Image 

Before using KnockMeColorOut, we setup our 
original image with the following: 

1. A solid blue strip 
2. A yellow-to-red gradient fade 
3. A spot white-to-red gradient fade (i.e., a 

white ink is part of this gradient) 
4. The word "WHITE" (with white text color) 
5. The word "RED" (with red text color) 

Transparent Mode  

(checker pattern = garment color) 

In the KnockMeColorOut preview, the 
Transparent option will use a checker pattern to 
represent where the garment color will show 
through. For our original image, the preview 
shows: 

1. The solid blue that will be printed. 
2. The yellow color that gradually blends to 

the garment color. 
3. The printed spot white that gradually 

blends to the garment color. 
4. The print spot white of the word "WHITE" 

For the word "RED," no ink is printed 
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Show Underbase- This preview mode shows the white underbase that will be created. 

Note that the preview is inverted, such that black areas represents the white underbase, and the white 
areas will underbase. 

Gray areas will represent a thin underbase layer will be printed to allow some of the garment color to 
show through. 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Show Underbase Mode  

(black = applied underbase ) 

The Show Underbase option uses black and 
shades of color to represent the printed white 
underbase, and a checker pattern where nothing 
is printed. 

1. Solid black that represents solid white 
underbase. The solid blue color will be 
printed atop the underbase. 

2. A black strip that fades to gray. The 
underbase is strongest at the left, where 
the yellow needs dominate the garment 
color. 

3. A black strip that fades to gray at the far-
right. Again, the underbase needs to be 
strongest at the left, where the white 
needs to dominate the garment color. 

4. The word "WHITE" appears black, since a 
solid white underbase will be applied here. 

5. The word "RED" appears white, since zero 
underbase will be applied. 

Of course, printing red ink on a red garment in 
step (5) doesn’t make sense, and we use this 
example for the sake of comparison. 
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Shirt Color - This preview mode combines the garment color, underbase and image colors to show the 
preview as i finished garment. The color picker can be used to choose the specific hue that represents 
the garment color. 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Shirt Color Mode  

(show garment color mixed with image ) 

The Shirt Color option shows the image colors as 
they will appear when printed on the garment, 
and a checker pattern where nothing is printed. 
For our example, the color picker has been set to 
red. 

1. A solid blue strip. The white underbase has 
been applied, and only blue should be 
visible on top. 

2. A yellow-to-red gradient fade. Inspection 
of the garment will show that less yellow is 
printed as the gradient blends into the red 
garment color. 

3. A spot white-to-red gradient fade. 
Inspection of the garment will show that 
less white is printed as the gradient blends 
into the red garment color. 

4. The word "WHITE" should appear as a solid 
white. 

5. The word "RED" will preview as red 
because it matches the red garment color. 

Of course, printing red ink on a red garment in 
point (5) does not make sense, and is only used 
here as an example. 
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Underbase  - Use this field to adjust the underbase strength (0..1000) that will be applied to the 

garment. The default underbase setting is 100 (about 10% of maximum). 

Increasing this value will cause more underbase to be laid down, which will increase the perceived color 
brightness in the printed image. 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Reset - Set all the dialog controls to their recommended defaults. 

Note: Changing the underbase setting does not change areas that will have 100% white ink in 
the underbase, nor area the underbase. Instead, the underbase setting will change the amount 
of white ink used to blend the garment color into shadow regions of the image). In effect, 

With an Underbase setting of 100, 
only about 10% of the selected hue is 
"knocked out," which provides a 
greater background contrast with the 
shirt color. This would be appropriate 
when printing onto a black shirt, so as 
to retain more of the red image. 

With an Underbase setting of 650 
(65%), this would be appropriate for 
printing to a red shirt. Less ink would 
be used to print the image color, 
thereby allowing the image to blend 
more naturally into the shirt color. 
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increasing the underbase can cause shadow regions of the original image to appear lighter and 
more visible. 

Transparency Opacity 
 

Some image file formats support the inclusion of an alpha channel, which is essentially a grayscale image that 
supplements the image. The alpha channel is often used to indicate where portions of the job should be 
transparent, thereby allowing the underlying garment material to show through. 

In the case of printing to black (or color) garment material, the alpha channel can be used to indicate areas (and 
to what degree garment color should show through, such that the printed colors will blend more naturally into 
that of the garment. Not only is less toner required to complete such jobs, but the printed colors will blend 
more naturally into that of the garment. 

In the following screenshots, the left-hand image is the original color image (a black squirrel amidst green 
grass), and the right-hand image is an alpha channel grayscale that has been specifically designed to indicate 
the blackest portions of the color image. In the lightest (white) portions represent areas that will show 
through, whereas black will be opaque. When printed, less ink will be according to the lightest portions, 
thereby allowing the garment to show through in those regions (presumably for black garment material). 

The same concept can be applied with color garment material, such as "knocking out" red in a design that will 
be printed to material. 

 

 
 

When using transparency to knock out portions of the printed image, a particular concern is the quality of 
gradient transition image and garment colors, since it is desirable to obtain the most seamless transition. If the 
alpha channel is not obtaining the desired quality, then the Transparency Opacity tool in IColor ProRIP can be 
used to adjust the alpha channel. 

For example, the following screenshot shows the Transparency Opacity dialog. The top image is the alpha 
channel, and the bottom image is a preview. Note that the color picker is black to indicate a black garment 
color, so the preview image shows black where the black garment will show through in the resulting print. 
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The dialog provides controls for adjusting the transition between white and black regions of the alpha channel. 
The alpha channel, like any image, is composed of shadow, midtone and highlight regions. In term of grayscale 
values that range from 0 to 255, shadows have low values approaching 0, and highlights have high values 
approaching 255. The midtones are the intervening shades between shadows and highlights. 
  
Midtones - This setting represents the approximate middle ground between shadows and highlights, such that 
the number of grayscale values is balanced between shadow/midtones and midtones/highlights. 
  
Transparent - The white regions of the alpha channel have a grayscale value of 255 (i.e., fully transparent). 
Reducing this value will reduce the white alpha regions, which allows more ink to be laid down in the 
transition areas (i.e., more coverage of the garment material). 
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Hard Clip - The transition areas between white and black represent the blending from image color to garment 
color, usually in the form of a gradient. Reduce the Hard Clip setting to create a sharper gradient transition, 
which makes it less likely for specks of ink to occur within gradients. 
 
Opaque - Increasing this value above zero will cause more of the image to be evaluated as black ink, thereby 
knocking out more of the image, and laying down less ink. 
  
Minimum and Maximum - The alpha channel, being a grayscale, has gray values that range from 0 (black, 
maximum opacity) to 255 (white, completely transparent). One way of considering the gray values (0.255) is as 
a series of steps that allow details to be discerned within the grayscale. 
By adjusting the Minimum and Maximum values to less than (0.255), the alpha channel will effectively have 
less of a range of detail available. However, adjusting this range can be necessary to omit the blackest and 
whitest portions of an “unbalanced” image that (say) has undesirable artifacts. 
  
Preview Mode 
The bottom preview image has three preview modes. 
Transparent - Use this option when the alpha channel is being used to knock out black (or color) from an 
image. 
 
Show Underbase - Use this option when the alpha layer is being used to define where a white underbase ink 
should be applied before printing the color image. 
 
With Color - Use the color picker to choose the approximate garment channel, so the image can be previewed 
as it will appear when printed. 
  
Invert - Flip the white and black values of the alpha channel, such that the transparent areas are reversed. 

 
Cleanup Black 

Cleaning the black within an image will adjust near-black pixels to make them black, which should cause 
the blacks to appear more solid. There are three degrees of Cleanup Black (x1, x2, and x3) that can 
applied. 

 

 

Original Cleanup Black x1 Cleanup Black x3 
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Cleanup White 

Cleaning the white within an image will adjust near-white pixels to make them white, thereby increasing 
the overall brightness of the image. There are three degrees of Cleanup White (x1, x2, and x3) that can 
applied. Be aware that increasing the intensity of white pixels can cause details to be lost within the 
highlight regions of the image. 

 
 

 

 

 

 

 

 
Original Cleanup White x1 Cleanup White x3 

 
Contrast 

The Contrast command adjusts the darkest blacks to black, and the lightest whites to white, to produce a 
more vibrant image. 

 
 

 

 

 

 
Original With Contrast Adjustment 
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Increase Saturation 

The Increase Saturation command will evaluate the job image and seek to obtain greater vibrancy from the 
colors. 

 
 

 

 

 

 
Original With Saturation Adjustment 
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Make Darker 

For the darkest regions of an image, the Make Darker commands will cause those regions to print closer to 
black. When using these commands, be cautious of losing details within the shadow regions of the image. 

 

 

                 Original                               Make Darker x1                             Make Darker x2 
 

Make Lighter 

The Make Lighter commands cause the lightness within an image to be more prominent. 
 
 

   
 Original Make Lighter x1 Make Lighter x2 
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Basic Application Printing 

The secret of really good garment printing is integrating the garment color into the design that is being 
printed onto the garment. When done properly, the image colors will blend into the garment, and the 
garment color will appear seamless wherever possible. IColor ProRIP provides unique tools that help you to 
accomplish specialized tasks for garment printing and achieving the best results with minimal work each 
time. 

In this chapter are special workflows for garment printing from PhotoShop, Illustrator, and CorelDraw. In 
addition, general workflows are provided for other design applications, such as Xara, GIMP, etc. 

 

Printing to White Garments 

Printing to a white garment is straight-forward because it is like printing an image to a white sheet of 
paper; the colors are simply absorbed into the garment, and the image is reproduced. As such, a minimal 
of file preparation (if any) is required when printing to white garment material. 

 

Printing to Black or Color Garments 

In contrast to white garments, printing on either black or color garments requires a specialized workflow to 
create an “underbase” layer that lays down a white primer, such that the garment color does not 
produce a hue shift in the image printed on the garment. This is similar to (say) house painting, where a 
white priming coat of paint is applied, so that the final layer of paint is not “polluted” by dark surfaces 
that existed prior to the primer. 

 

Simulating the Shirt Color 

When editing the design in your graphic design software, it can be helpful to create a solid fill background 
object that simulates the garment color for you. However, take care to hide/delete the background 
object before printing. 

For design software that allow you to organize a design onto layers (e.g., PhotoShop, CorelDraw, etc.), put 
the background object on its own layer, and then hide the layer before printing. In this manner, the 
background object can be quickly hidden as required, such as after doing subsequent edits to the design. 

 

Underbase Shortcuts - Send to IColor ProRIP 

When IColor ProRIP is installed, special Send to IColor ProRIP plug-ins are created for your PhotoShop, 
Illustrator and CorelDraw design applications, such that your designs can sent directly to IColor ProRIP. 
Sending designs in this fashion eliminates the extra steps required by the File menu >> Print dialog, and 
underbase information is automatically generated. In this manner, IColor ProRIP streamlines the garment 
printing workflows for your designs. 
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Tips for Image File Formats 

The File menu >> Print command will discard the alpha layer (i.e., transparency) information that was 
prepared for the image, which prevents IColor ProRIP from using the alpha layer to generate an 
underbase layer. As such, it is necessary to save your image in either PSD, TIFF or PNG format, which can 
then be imported into IColor ProRIP. 

Likewise, the following are common situations where it is necessary to save your image file and bring it into 
the IColor ProRIP window: 

 

The customer is providing the artwork, and you wish to avoid further editing of 

the artwork. The design computer is separate from the computer on which 

IColor ProRIP is installed. 

The design computer is a Mac OSX system. 
 

If you need more of an automated system of printing between networked computers, then it is possible to 
configure a Hot Folder in IColor ProRIP, such that copying the image file into the hot folder is automatically 
detected and printed. 

 

Saving a PSD File Out of PhotoShop 

Saving in PSD format is encouraged because it provides the greatest compatibility when making 
further edits in PhotoShop. 

Before saving the image, make certain that there will be maximum compatibility between PSD 
and PSB files. This can be set via Edit menu >> Preferences >> File Handling >> Maximize PSD 
and PSB File Compatibility = Always. 

Alternatively, this can be set to Ask, which will prompt you each time that a PSD file is saved. 

With maximum compatibility with PSB, most PSD files should work without issue. However, if 
your image is composed of multiple layers, particularly with text and objects each with their 
own underbase, then it may be necessary to save the image as a single layer job. Use the 
Layers menu >> Merge Layers command to collapse such layers before saving. 

When saving, always tick the ICC Profile checkbox, such that an embedded profile is saved with the 
image. 

In most cases, you will want to clear the Layers checkbox = OFF. This will cause the design to be 
flattened to   a single layer, which prevents stray (unnoticed) transparency within the design 
from interfering with the underbase or spot channel information that you have prepared. 
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Exporting a PSD File from Illustrator 

Use the following steps when creating a PSD file from Illustrator: 

1) Choose File menu >> Export 

2) Choose a location and filename for saving. 

3) The PhotoShop Export Options dialog will open. 

4) Set Resolution = 300 ppi 

5) Click the Flat Image option. 

6) Clear the Anti-alias checkbox. 

7) Tick the Embed ICC Profile option. 

8) Click OK to continue. 
 

TIFF Format 

When saving in TIFF format, tick the Layers checkbox. 

When saving, always tick the ICC profile checkbox, such that an embedded profile is saved 

with the image. If available, then tick the Save Transparency checkbox. 

 

PNG Format 

The PNG format does not support the embedding of color profiles. As such, more care might 
be required to ensure that the correct profiles are used with the PNG file, especially if you 
are reusing a PNG file from a previous job. 

 
 

JPEG Format (special mention) 

Saving as JPEG is not workable. Though the specification for JPEG files does allow for storing 
underbase information, PhotoShop does not currently support storing of underbase information in 
JPEG format. 

 
Please refer to the Help Topics file (Basic & Advanced Application Printing) within the ProRIP program for 
further information regarding printing and advanced job preparation from Photoshop, Illustrator and 
CorelDraw 

Overview of the Queue Menu Wizards 
 

Start with the Set Maximum White Ink wizard, and continue with each subsequent wizard that is relevant to 
your testing. You will quickly see the logic in how these charts help you to winnow out the bad results. 

Using a notebook, keep track of your choices, including comments about your successes with the printed 
charts. By building a test history, this will give you experience for the future when want to evaluate other 
garment manufacturers. 
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Set Maximum White Ink 

It is the white ink that bonds with the garment pretreatment, and the color inks bond to the white. As such, 
you want to determine the maximum amount of ink that the garment can absorb, without causing bleed 
issues. 

 

Setup Black Removal 

For printing to black garment material, you want to determine how much black ink that you can remove from 
the printed graphic, so that you reduce ink usage and help the graphic blend more naturally. 

Setup White Under Black 

For printing to either color or black garment material, most DTG printers require white ink to be printed 
beneath all  colors, otherwise those areas will fade when the material is washed. With this in mind, for 
each of your printed charts, you should perform actual wash tests to observe how much image fading 
occurs. 

 

Set White Choke 

As a precaution against registration errors, choking the white underbase will help to avoid the risk of 
white appearing along the edges of the artwork. 

 

Setup Color Boost 

When transparency information is being used to cause portions of the garment to show through the 
printed graphic, this will cause flattening of the printed colors, causing them to appear less vibrant. To 
compensate for this, the color boost setting will compensate for the flattening by increasing the amount 
of color ink. 

 

Setup Photo Merge 

When printing a job that combines both graphic elements (e.g., a logo) with photographic elements (e.g., a 
landscape), the colors of both graphic and photograph can be best retained by blending a Relative rendering 
intent (i.e., best for graphics) with a Perceptual rendering intent (i.e., best for photographs). 
 
Set Maximum White Ink 

 
 
Queue menu >> Setup Maximum White Ink 

You need different amounts of white ink for different garment material. This is particularly true when 
comparing garment materials from different manufacturers, where the amount of white underbase will 
vary when seeking a solid, opaque white. 
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For the following two shirts from different manufacturers, each were printed using the same pre-treatment 
and queue settings, but the quality varies according to the garment quality. 

 
Though this emphasizes the need to obtain high quality materials that are suitable for garment printing, it 

also illustrates the importance of determining the maximum amount of white underbase that can be 
applied. Still, care must be taken, otherwise too much ink will cause bleed issues, such as white speckles 
that become visible after the heat process. 

 
 

Set Maximum White Ink Dialog 
 

The Set Maximum White Ink dialog is a wizard that will guide you to print a series of test images, whereby 
you will be able to quickly determine the correct white underbase for obtaining the best print quality. 

1. Choose Queue menu > Set Maximum White Ink 

2. The Set Maximum White Ink dialog will open to the Page Size settings. 

3. Set the Page Size 

Several copies of your test image will be arranged on this page. 

4. For the Graphic, click […] to choose your test image file. 

It is important to use an image file that is representative of the sort of jobs that you will be performing. 

From the IColor ProRIP installation directory, image files are available in the Rip\system\targets 
subdirectory. 

5. Set the size at which each test image will be printed. 

6. At the right, the preview will show how many test images fit on the page. 
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7.     Click Next to proceed with the Maximum White Setting page. 

Using your test image, this page will create a series of charts that vary according to a range of 
KnockMeBlackOut settings. 

 

 
8.     For example, set the Maximum White chart settings as follows: 
Set Minimum = 50 
Set Maximum = 100 
Set Increment = 50 
In other words, there will be four charts with black removal values of 30, 45, 60, and 75. 
  
9.     Click the Print Max White ink chart button. 
 
10.  In iColor ProRIP, the print job will be added to the queue. 
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11.             For each chart that is printed, its max white value will be printed alongside that chart. 

12.             After identifying the chart that you consider to have the highest quality, return to the dialog and 
enter the black removal value. 

 
 

 

 

 

 

 

 

13.             (Optional) In addition to determining the white percent value, you can proceed with the following 
two wizards: 

●      Run setup black removal – For black shirt queues, this option is equivalent to choosing Queue menu > 
Setup Black Removal. 
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●      Run setup white under black – For color shirt queues, this option is equivalent to choosing Queue menu 
> Setup how much white to use under black. 

 

 
 

 

14.             Click Next to proceed to the Saving Settings page. 

15.             You are presented with three choices as to where your changes will be set: 

●      Only apply to the queue 
●      Apply to current print mode  
●      Create a new print mode 

16. Click Finish to commit your setting. 
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Setup Black Removal 
 
 

Queue menu >> Setup Black Removal 

For printing to a black substrate, the Setup Black Removal feature will help you to perform test prints that 
determine the optimum amount of black ink that can be removed from incoming printed jobs, such that 
the black garment will substitute for the removed ink. 

• It is important that you perform test prints with different image files that are 
representative of the output that you want. Otherwise, the risk is that doing tests using 
a single image file will overlook issues that would have been apparent in other files. 

• As you perform tests using each image file, you should collect notes about the settings 
that produced good results for that image. As you repeat the tests with a different 
image file, you can compare the results, and perhaps determine average settings that 
are acceptable across a wider variety of images. 

• If your image files are too varied in their composition, then you could create extra 
queues for special cases, such as a queue that is good for holding details within the 
shadow regions of an image, or a queue that is more aggressive   at removing black. 

 
Setup Black Removal Dialog 

 
The Setup Black Removal dialog is a wizard that will guide you to perform print tests in two stages. 

• First, you will evaluate a series of test prints to determine the correct black ink removal 
setting. 

• Second, you will evaluate a series of test prints to determine the correct amount of 
white underbase that will be used in areas that are semi-transparent, or where you 
want the substrate color to show through. 

1. Choose Queue menu > Setup Black Removal 

2. The Setup Black Removal dialog will open to the Page Size settings. 

3. Set the Page Size 

Several copies of your test image will be arranged on this page. 
 

4. For the Graphic, click […] to choose your test image file. 

It is important to use an image file that is representative of the sort of jobs that you will be performing. 

From the IColor ProRIP installation directory, image files are available in the Rip\system\targets 
subdirectory. 

 

5. Set the size at which each test image will be printed. 

6. At the right, the preview will show how many test images fit on the page. 
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7. Click Next to proceed with the KnockMeBlackOut Setting page. 

Using your test image, this page will create a series of charts that vary according to a range of 
KnockMeBlackOut settings. 

 

 
 

8. For example, set the KnockMeBlackOut chart settings 

as follows:  

Set Minimum = 30 
Set Maximum = 75 
Set Increment = 15 
In other words, there will be four charts with black removal values of 30, 45, 60, and 75. 
 

9. Click the Print KnockMeBlackOut chart button. 

10. In IColor ProRIP, the print job will be added to the queue. 
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11. For each chart that is printed, its black removal value will be printed alongside that chart. 

12. After identifying the chart that you consider to have the highest quality, return to the dialog and 
enter the black removal value. 

 

 
 

13. Click Next to proceed with the White Levels page. 

● This page can involve printing multiple sets of charts, depending upon what you feel is necessary, to 
determine the correct amount of white underbase that should be applied. 

● The white underbase is what helps the print job adhere to the substrate, and without the white 
ink, the printed colors will fade rapidly over time (e.g., such as when laundering a printed 
garment). 
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14. From the Select set drop-list, there are four series of chart variations (1-4), and each series has 
four samples (A- D), as indicated in the following table. 

 
 

Set Description Chart series Has samples 

Strong White midtones- 
shadows 

Use more white ink in the 50 
90% region 

1 A1, B1, C1, D1 

Medium plus 
White midtones-
shadows 

 2 A2, B2, C2, D2 

Medium White 
midtones- shadows 

 3 A3, B3, C3, D3 

Light White midtones- 
shadows 

Use less white ink in the 50- 
90% region 

4 A4, B4, C4, D4 

 

Each set represents four variations of the amount of white ink that will be printed using your test image. 

●      These sets control how strong that white will be printed in the highlights, midtones, and shadow regions. 
●      The sets will not change the 100% white ink value. To change the 100% white, please refer to the 
Maximum White Ink feature. 
●      Each set affects different amounts of ink in the 30% to 95% shadow region. 
●      Each of these charts will print four variations with different amounts of white ink between 10% and 30%.  

15.       Choose the set that you want to test, and then click the Print white levels chart button. 

●      Print as many of these charts as you feel that you need for testing. 
●      However, where you use less white ink, you will lose color vibrancy in those areas. 

16. After completing your testing, return to the dialog, choose both the set, and the sample number, of 
the sample that you visually observed as having the best result. 

 

mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/Maximum_White_Ink.htm
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17. Click Next to proceed to the Saving Settings page. 

18. You are presented with three choices as to where your changes will be set: 

● Only apply to the queue 

● Apply to current print mode 

● Create a new print mode 
 

19. Click Finish to commit your setting. 
 
Setup White Under Black 

 
Queue menu >> Setup how much white to use under black 

The Setup White Under Black feature can be used when printing to either a color garment, or a black 
garment. In the case of black garments, the following should be emphasized: 

● Most DTG printers require white ink to be printed beneath all colors, otherwise those areas will 
fade when the material is washed. 

● This fading occurs because the pre-treatment is designed to bond to the white ink, but not the CMYK. 

● In addition to printing the test charts, you should perform some actual wash tests in order to 
observe how much image fading occurs with respect to varying percentages of white ink. 

● Another consideration is that by applying a good amount of white ink under black, this will produce a 
glossy black. 

 
Setup White Under Black Dialog 

 
The Setup White Under Black dialog is a wizard that will guide you to perform print tests in two stages: 

● First, you will evaluate a series of test prints to determine the correct amount of white 
underbase to print under black ink. 

● Second, you will evaluate a series of test prints to determine the correct amount of white 
underbase to print when the substrate color will be showing partially through. 
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1. Choose Queue menu > Setup Black Removal 

2. The Setup Black Removal dialog will open to the Page Size settings. 

3. Set the Page Size 

Several copies of your test image will be arranged on this page. 
 

4. For the Graphic, click […] to choose your test image file. 

It is important to use an image file that is representative of the sort of jobs that you will be performing. 

From the IColor ProRIP installation directory, image files are available in the Rip\system\targets 
subdirectory. 

 

5. Set the size at which each test image will be printed. 

6. At the right, the preview will show how many test images fit on the page. 
 

 
 

7. Click Next to continue with the Underbase Strength page. 

Using your test image, this page will create a series of charts that vary according to the underbase 
strength that will be printed under black ink. 
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8. For example, set the Underbase strength settings as follows: 

Set Minimum = 19 0% White under black 

Set Maximum = 28 90% White under black 

Set Increment = 3 

In other words, there will be four charts with underbase strength values of 19, 22, 25, and 28. 

Note: If you go below 19, then you will also be removing white from dark colored areas. 

 
9. Click the Print underbase strength chart button. 
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10. In IColor ProRIP, the print job will be added to the queue 

11. For each chart that is printed, its underbase strength value will be printed alongside that chart. 

12. After identifying the chart that you consider to have the highest quality, return to the dialog 
and choose the underbase strength value. 

Note: It is recommended that wash tests be performed before choosing your underbase 
strength setting. 

 
 

13. Click Next to proceed with the White Levels page. 

● This page can involve printing multiple sets of charts, depending upon what you feel is necessary, to 
determine the correct amount of white underbase that should be applied. 
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● The white underbase is what helps the print job adhere to the substrate, and without the white 
ink, the printed colors will fade rapidly over time (e.g., such as when laundering a printed 
garment). 

Note: This wizard does not affect the 100% white ink setting, which is determined using 
Queue menu > Set Maximum White Ink 

 

 
 

14. From the Select set drop-list, there are four series of chart variations (1-4), and each series has 
four samples (A- D), as indicated in the following table. 

 

 
Set Description Chart series Has samples 

Strong White midtones- 
shadows 

Use more white ink in the 50 
90% region 

1- A1, B1, C1, D1 

Medium plus 
White midtones-
shadows 

 2 A2, B2, C2, D2 

Medium White 
midtones- shadows 

 3 A3, B3, C3, D3 

Light White midtones- 
shadows 

Use less white ink in the 50- 
90% region 

4 A4, B4, C4, D4 

 
Each set represents four variations of the amount of white ink that will be printed using your test image. 
●      These sets control how strong that white will be printed in the highlights, midtones, and shadow regions. 
 
●      The sets will not change the 100% white ink value. To change the 100% white, please refer to the 
Maximum White Ink feature. 
 
●      Each set affects different amounts of ink in the 30% to 95% shadow region. 
 
●      Each of these charts will print four variations with different amounts of white ink between 10% and 30%. 
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15.    Choose the set that you want to test, and then click the Print white levels chart button. 
●      Print as many of these charts as you feel that you need for testing. 
 
●      However, where you use less white ink, you will lose color vibrancy in those areas. 
  
16.    After completing your testing, return to the dialog, choose both the set, and the sample number, of the 
sample that you visually observed as having the best result. 

 

 
 

17.   Click Next to proceed to the Saving Settings page. 

18.   You are presented with three choices as to where your changes will be set: 

●      Only apply to the queue 
●      Apply to current print mode  
●      Create a new print mode 

19.    Click Finish to commit your setting. 

 
Set White Choke 

 
Queue menu >> Set White Choke 

When printing a design that has a spot white underbase, registration issues present the risk that the white 
will appear along the edges of the artwork, thereby creating a halo effect. Applying a choke to the white 
underbase will prevent the white     ink from being printed anywhere within a few pixels of the artwork 
edges. This choke provides a margin-of-error should it happen that the color pass does not fall precisely as 
intended upon the white underbase. 
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Set White Choke Dialog 

 
In order to quickly determine the best choke amount, the Set White Choke feature allows you to print a 

series of test images, from which you will choose the choke value that obtains the best result. This choke 
value will then be set as the default for all subsequent print jobs. 

1. Choose Queue menu >> Set White Choke 

2. The Set White Choke dialog will open to the Page Size settings. 

3. Set the Page size 

Several copies of your test image will be arranged on this page. 
 

4. For the Graphic, click […] to choose your test image file. 

It is important to use an image file that is representative of the sort of jobs that you will be performing. 

From the IColor ProRIP installation directory, image files are available in the Rip\system\targets 
subdirectory. 

 

5. Set the size at which each test image will be printed. 

6. At the right, the preview will show how many test images will be printed. 
 

 
 

7. Click Next to proceed to the Choke Setting page. 
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8. For the Choke settings: 
Set Minimum = 0 None 
This test image will have zero choke. 
  
Set Maximum = 5 Maximum 
●      It is not recommended to use a choke value higher than 5. 
●      A choke higher than 5 can cause the image quality to noticeably degrade. 
●      For example, a change in hue can occur along the edges, such that the image appears to have a stroke. 
●      In an extreme case, the job colors will be completely lost, creating the effect of a smear along the image 
edges. 

Set Increment = 1 

This will print test images from 0 to 5, using increments of 1. 

9.     Click the Print choke chart button. 
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10.             In iColor ProRIP, the print job will be added to the queue. 

 

11.             Print the job, and visually examine the result, noting that each test image has been printed with its 
choke value. 

12.             Back in the dialog, enter the choke value that produced the best test image. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
13.             Click Next to proceed to the Saving Settings page. 
 
14.             You are presented with three choices as to where your choke value will be set: 
●      Only apply to the queue 
●      Apply to current print mode  
●      Create a new print mode 
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15.             Click Finish to commit your choke setting. 
 
Setup Color Boost 

 
Queue menu >> Setup Color Boost 

 
When printing an image that has portions where the substrate will show through, the Setup Color Boost 

feature will increase the amount of color ink being printed, so that the resulting colors will appear more 
vibrant. 

Color boost is necessary because the amount of transparency information within the image is not 
optimized for the inks and substrate being used. In other words, for the transparent areas of the printed 
image, the colors will generally be scaled back too much, which reduces their effectiveness. Color boost 
allows you to quickly correct for this. 

 
Note: Color boost will not affect solid colors that are printed with a solid white underbase. 

 

Setup Color Boost Dialog 
 

The Setup Color Boost dialog is a wizard that will print several test copies of an image, each at a different 
color boost setting, and you will choose the boost setting that achieves the best result. 

1. Choose Queue menu > Setup Color Boost 

2. The Setup Color Boost dialog will open to the Page Size settings. 

3. Set the Page Size 

Several copies of your test image will be arranged on this page. 
 

4. For the Graphic, click […] to choose your test image file. 

It is important to use an image file that is representative of the sort of jobs that you will be performing. 

From the IColor ProRIP installation directory, image files are available in the Rip\system\targets 
subdirectory. 

 

5. Set the size at which each test image will be printed. 

6. At the right, the preview will show how many test images fit on the page. 
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7. Click Next to proceed to the Color Boost Setting page. 
 

 
 

8. For the Color boost 

chart settings: Set 

Minimum = 1 

A color boost of 1 is normal flattening (i.e., no color boost). 
 

Set Maximum = 8 

A color boost of 8 is high. 
 

Set Increment = 1 

This will print test images from 1 to 8, in increments of 1. 
 

9. Click the Print color boost chart button. 

10. In IColor ProRIP, the print job will be added to the queue. 
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11. Print the job, and visually examine the result, noting that each test image has been printed 
with its color boost value. 

12. Back in the dialog, enter the color boost value that produced the best test image. 
 

 
 
 
 
 
 
 
 
 
 
 
 

13. Click Next to proceed to the Saving Settings page. 

14. You are presented with three choices as to where your color boost value will be set: 

● Only apply to the queue 

● Apply to current print mode 
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● Create a new print mode 
 

15. Click Finish to commit your color boost setting. 
 
Setup Photo Merge 

 
Queue menu >> Setup Photo Merge    

When printing a job that contains both graphic elements (e.g., a logo), and photographic elements (e.g., a 
landscape), this 

presents a need to blend a Relative rendering intent (i.e., best for graphics) with a Perceptual rendering intent 
(i.e., best for photographs). 

The Setup Photo Merge feature is used to determine the correct amount of blending (i.e., Merge setting) 
between these rendering intents, so that satisfactory color reproduction occurs for both the graphic and 
photographic elements. 

 

Note: For printers that have a relatively large color gamut (e.g., solvent printers), you will not see a 
significant difference between Relative and Perceptual rendering intents. The difference is more 
pronounced with small color gamuts, such as with DTG printers, or when using A+B sheets with laser 
printers. 

 

Setup Photo Merge Dialog 
 

1. Choose Queue > Setup Photo Merge 

2. The Setup Merge for Photo Rendering dialog will open. 

3. Set the Page Size 

Several copies of your test image will be arranged on this page. 
 

4. For the Graphic, click […] to choose your test image file. 

It is important to use an image file that is representative of the sort of jobs that you will be performing. 

From the IColor ProRIP installation directory, image files are available in the Rip\system\targets 
subdirectory. 

5. Set the size at which each test image will be printed. 



 
95 

 

At the right, the preview will show how many test images fit on the page. 

6. Click Next to proceed with the ICC Photo Setting page. 

Using your test image, this page will create a series of charts that vary according to a range of 

merge settings. A lower merge will favor logo graphics, whereas a higher merge will favor 

photographic elements. 

 
 
 

 

 

 

 

7. For example, set the Photo merge settings as follows: 

Set Minimum = 0 
Set Maximum = 100 
Set Increment = 20 
In other words, there will be six charts with merge values of 0, 20, 40, 60, 80 and 100. 

 

8. Click the Print photo merge chart button. 
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9. In IColor ProRIP, the print job will be added to the queue. 

10. For each chart that is printed, its marge value will be printed alongside that chart. 

11. After identifying the chart that you consider to have the highest quality, return to the dialog and 
enter the merge value. 

 
 
 
 
 
 
 
 
 
 
 

 
 

12. Click Finish, and the merge value will be set in the properties of the current queue. 
 
Jobs Menu 

 
When a print job is received in a queue, the Jobs menu controls can be applied to that job. Select the job and 

then choose from the Jobs menu. Alternatively, these controls are available from the context menu when 
right-clicking the job. 
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• Restore Jobs - Manage archived print jobs. See Job Reserve Tab and Archiving 
• Select All - Selects all jobs in queue. 
• Select None - Clear current selection. 
• Remove - Delete the selected job. 
• Rename - Change the job name. 
• Open Page - Spooled jobs are considered closed because they contain the print data that is ready for 

sending to the printer. Use Open Page to discard the spool data, such that the unspooled job is 
available for scaling, rotating, etc. 

• Find Job (using barcode) - Scan or enter the barcode of a printed job, and the corresponding cut 
portion will be located. 

• Release - Release a held job for printing. 
• Hold - Stop the job, regardless of whether the queue is stopped. 
• Abort - Cancel the selected job (i.e., cease sending data to the printer). 
• Clear Error - If a problem occurs when printing (such as paper out), the job will be flagged with an error 

and put on hold. After the printing problem is resolved, click Clear Error to remove the error flag. 

If a job has encountered an error condition, then the job properties will summarize the errors. The job 
properties also include a detailed Log of the tasks that were completed before the error was 
encountered (see the Log tab). 

• Color Adjust - For the selected job, open the Easy Color Adjustments dialog. 
• Add to Layout - This command is applied to unscheduled jobs. The given job will be moved into the 

Active List and its layout shown in the Visual Print Manager. 
• Print - Begin printing the job (i.e., spool the job and send the print data to the printer). 
• RIP Only (Preview) - Spool the print data without sending to printer. The spool file is retained on the 

hard drive, which can be previewed by right-clicking the job and choosing View Raw Data. 
• Save As (Archive to Disk) - Store the job in an archive location, such that it can be restored at a later 

date. 
• Generate Preview Image - Generate a thumbnail of the job that is displayed in the Active List. 

Thumbnails can be automatically generated per Tools menu >> Options >> Preview Options. 
• Properties - Open the Job Ticket Properties dialog, which displays all the settings that the job 

"inherited" from the queue properties. 

 
Devices Menu 

 
The Devices menu provides tools for installing printer support files, customizing print mode settings, and 

printing test pages to confirm print quality. 
 

Manage Devices 
 
 

Devices menu >> Manage Devices 

The Manage Devices dialog is used to install new printers, and check for support file updates. 
 

mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/JobReserveTab_DFA_v10.htm
mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/BarcodeSupport_v10.htm
mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/LogTab_DFA_v10.htm
mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/Easy_Color_Adjustments_VPM10.htm
mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/PreviewingRawPrintData_v10.htm
mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/JobReserveTab_DFA_v10.htm
mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/Preview_Options_VPM10.htm
mk:@MSITStore:C:%5CiColor%20ProRIP%5Cpsqueue.chm::/Queue_Properties_DFA_v10.htm
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Manage Print Modes 
 

When a new printer is installed, a collection of print modes (e.g., media profiles) are included for printing 
with a range of manufacturer medias, ink sets, and printer resolutions. The Print Mode Manager is used 
to inspect, rearrange, and modify the media profiles for a given printer. 

For any print mode that was installed as part of the IColor ProRIP product, these are considered to 
be read-only and are not editable. However, the solution is to make a copy of the given print 
mode, and the copy will be writable. 

For any print mode that you have created, it is considered to be writable. As such, it is recommended 
that a copy be made prior to significant edits. 

For a print job that is pending (being held) in IColor ProRIP , its print mode properties can be edited 
without changing the original print mode. 
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Copying a Print Mode 

1. From the Printers menu, choose Manage Print Modes to open the Print Mode Manager dialog. 

2. From the drop-list, choose the printer model. The print modes for that printer will then be listed. 

3. Click the print mode, such that the name is highlighted. 

4. Along the top of the Print Mode Manager dialog, click the Copy Print Mode button. 

5. When prompted, type a meaningful name for the copy. 
 

 

Editing a Print Mode 

1. From the Printers menu, choose Manage Print Modes to open the Print Mode Manager dialog. 

2. From the drop-list, choose the printer model. The print modes for that printer will then be listed. 

3. Click the print mode, such that the name is highlighted. 

4. Along the top of the Print Mode Manager dialog, click the Edit Print Mode button. 

5. The Properties dialog for the print mode will open (see Queue Properties). 

 

 

 
 



 
100 

 

Marking Print Modes as Favorites 

1. In IColor ProRIP , choose Printers >> Manage Print Modes. 

 
2. Next to the print mode names column, there is a "Favorite" column (as indicated by the 5-pointed 

star). 

3. To mark a print mode as a favorite, click within the Favorite column. 

4. Later, when using the Print Mode Selection dialog to choose a print mode, the "Star" column 
will indicate the print modes that are considered to be favorites. 
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Hiding Print Modes 

To prevent users from selecting the wrong print mode, the Print Mode Manager dialog can be used to hide 
print modes. 

1. In the IColor ProRIP , choose Printers >> Manage Print Modes. 

2. Set all of the drop-lists to "All," so that the full list of print modes are displayed. 
Note: As a memory aid, it may be desirable to use the Favorites column to mark the print 
modes that will not be hidden in the subsequent steps.  

 

3. Next to the Favorites column (the 5-pointed star), there is an "Approved" column (as 
indicated by the checkmark within a red circle). 

4. By default, all of the print modes are approved. 

5. To hide a print mode, click to remove the circled checkmark within the Approved column. 

6. Click Close to finish editing the Print Mode Manager. 
 

In SignLab, only approved print modes will be selectable via the Print and Cut Setup dialog. 

In third-party graphic software applications, only approved print modes will be selectable via the Print dialog. 



 
102 

 

Overriding the Print Mode Setting of a Print Job 

When a print job is being held in the queue, its print mode properties can be edited prior to print. These 
edits will apply only to the given job without changing the original print mode. 

1. In IColor ProRIP , click the Stop Queue button. This will cause new print jobs to be held pending. 

2. Print a job to IColor ProRIP . 

3. The print job will now be listed in the IColor ProRIP . 

4. Right-click the print job and choose Properties. 

5. The Job Ticket Properties dialog will open. 

6. Any changes to these dialog settings will override the print mode for this job. 

 

Print Mode Manager Toolbar Options 

Along the top of the dialog are several toolbar buttons, which are used to rearrange, copy, edit, and 
organize a selected print mode. Please note that it may be necessary to create a copy of a print mode 
before it can be edited or moved. 

 

 
Folder Editing refers to the folder icons that are used to indicate a category of print modes, such as 

from a specific manufacturer. After a folder has been created, your custom print modes can be 
dragged into the folder using the cursor. 

The Print Mode Editing tools are Delete, Copy, Rename, and Edit. Before editing or moving a preset 
print mode, it is necessary to make a copy of that print mode, which will then be editable. 

The Package  Editing tools are used to export and import your custom print modes, such that they can 
be backed up or sent to another workstation. When creating a package, all of the custom print 
modes will be listed. Choose the print modes that should be added to the package, and then click 
Save. 
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Manage Print Media 
 
 

Devices menu >> Manage Print Media 

The Printer Media Manager dialog shows the types and dimensions of media that are available for your 
printer. See also: Media Setup Tab 
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Manage Spot Colors 
 
 

Devices menu >> Manage Spot Colors 

The Manage Spot Colors command will open the System Spots dialog, which is used to define CMYK/RGB/ 
L*a*b* colors that will be available to all machines. 

To define a new color, click within an empty row and type the given value. Press [Tab] to advance to 
the next available cell. If pressing [Tab] advances to the next row, then values for the next row can 
be entered, and so on. 

To delete a row, click its left border, such that the entire row is selected, and then press the [Del] key. 
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Manage Device Spots 
 
 

Devices menu >> Manage Device Spots 

The Manage Device Spots command will open the Device Colors dialog, which is used to define colors for 
a specific printer. The Printer drop-list indicates the machine for which new colors will be created, and 
the Colors drop-list indicates the color channels that will define the given color. Other machines will not 
have these colors automatically. 
Instead, use the Import and Export buttons. 

Note: The number of choices from the Colors drop-list varies according to the Printer that is selected. 

 
After the Printer and Color choices have been made, define a new color by clicking within an empty row 

and typing a value. Press [Tab] to advance to the next available cell. If pressing [Tab] advances to the 
next row, then values for the next row can be entered, and so on. 
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Spot Plane Mapping 
Devices menu >> Spot Plane Mapping 
Queue Properties >> Layer Profile 

Note: Spot color synonyms will only apply when importing PDF, PostScript, or EPS files. 

A spot color synonym is an alternative name for the actual spot channel that will be output (e.g., White, Silver, 
Clear, etc.). For example, if an imported PDF file has spelled a spot color name in a way that your printer 
would not recognize, then create a synonym that maps the imported color to what your printer uses. 

Synonyms are not device specific, which means that a defined synonym can be reused when you switch to 
a different printer that uses the same channel naming conventions. 

 

Configure a Spot Color Synonym 
 

Before creating synonyms, construct a list of the spot color names that will potentially be used in design 
files. For each spot color name, determine the correct color channel name that will be used when 
outputting the print job. 

Note that the correct spelling of color channel names can be referenced via Queue menu >> Properties >> 
Separation Curves >> Colors. 

The Separation Curves tab is only visible when Tools menu >> Options >> General tab >> Show advanced 
settings = ON 

1. In IColor ProRIP, choose Devices menu >> Spot Plane Mapping 

2. In the Plane substitutions dialog, set Use spot name mapping = ON 

3. Click the Add Original button, and enter the channel name that is used when output to the printer. 

4. The channel name will appear under the Color plane column, and a corresponding drop-list will appear 
under the 

Spot color in job column. 
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5. From the drop-list, choose Add Synonym. 

6. The Substitute XXX with dialog will open. 

7. Type the color name as it was defined in the original design. 
 

To summarize the screenshot example: 

1) The print mode for this printer has “White” as a defined channel. 

2) In the original design, “MY_WHITE” was defined as a spot color. 
3) Using the Plane substitution dialog, we defined MY_WHITE as a synonym for “White,” so that 
all areas of MY_WHITE will be printed as the White channel on the printer. 

 

Tools Menu 
 

The Tools menu provides access to RIP settings, such as allocated RIP memory, and concurrent print job 
processing. 

 

Options Dialog 

The Options dialog provides interface preferences and RIP system settings. 

General - Provides basic controls for customizing the IColor ProRIP interface. 

Storage and Archiving - This tab indicates where the production files are stored when the queues are 
processing jobs, and the location of archived jobs. 

RIP - Allocate memory for the RIP, and set the relative priority of jobs with respect to other Windows 
applications. 

Processing - Spool extra jobs whilst waiting for the current print job to finish. 

Preview Options - Adjust the thumbnail image quality for jobs in the active list. 
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Printing Direct to Port 

Direct to Port - This is a diagnostic tool that sends print data to a specific computer port, so as to 
confirm that data is being received by the print that is connected to that port. 

 
General Interface Settings 

Tools menu >> Options >> General 
  

The General tab provides basic controls for customizing IColor ProRIP : 

Show splash screen - When launching IColor ProRIP, this checkbox controls whether the IColor 
ProRIP splash screen will be displayed. 

Always on top - If this checkbox is ticked (ON), then IColor ProRIP will always remain in the foreground 
"above" other windows. 

Automatically  track  items  - If this checkbox is ticked (ON), then selecting a job in the active list or 
archive list will display details about that job in the Media Settings pane. When OFF, it is necessary 
to select a job in the Visual Print Manager in order to display such details. 

Set display units - Choose the unit of measurement that will be used throughout IColor ProRIP. 

Set decimal places - Choose the precision of measurements used in IColor ProRIP. 

User hidden dialogs - IColor ProRIP uses warning dialogs to confirm whether a given action should 
proceed. Such warning dialogs have a checkbox that can be checked to prevent that warning dialog 
from reoccurring. However, if there is a new user that is learning how to use IColor ProRIP, then 
click the Reset All button to force all dialogs to be shown again. Alternatively, click Advanced to 
select which warning dialogs to show. 

Storage and Archiving 

Tools menu >> Options >> Storage and Archiving tabThis tab indicates where the production files are stored 
when the queues are processing jobs, and the location of archived jobs. 
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Base Folder - This is the hard drive location where queue settings will be stored. By default, this 
location is set during IColor ProRIP installation. 

Volumes - The volumes are all the possible storage locations wherein the Base Folder can be set, 
such as a hard drive or flash drive. 

Archive Location - The archive location is the directory where archived jobs will be stored. This needs 
to be a location that can be accessed later to restore the given job. 

 

RIP System Settings 

 
Tools menu >> Options >> RIP 
  

The RIP Settings are used to specify the resources that are available for spooling (rasterizing or RIP’ing) print 
jobs. These controls will directly influence the workstation that is performing the RIP calculations. 

 

RIP System Location 

The RIP System Location explicitly states the directory to which the RIP engine for IColor ProRIP has been 
installed. This information is provided to help CADlink Tech Support diagnose issues quickly. 

 

RIP Memory Allocation 

Memory refers to the maximum amount of workstation memory (RAM) that may be used by the queue 
when creating a spool file. If more than this limit is required, then Virtual Memory (VM) will be used. 
Virtual Memory refers to hard drive space that is used to supplement RAM. Virtual Memory is used to 
effectively provide applications with more RAM than the workstation has installed. However, accessing 
hard drive space is much slower than real memory. 

RIP Priority Level 

All software processes have a Priority Level that determines how the workstation processing time is shared 
amongst the processes (different software applications). Normally, processes are assigned equal priority 
levels by default, but modifying the priority of individual processes is acceptable where this improves 
overall workstation performance. 

If the RIP Priority Level is increased, then print jobs will be processed faster, though this will be to the 
detriment of all other software processes that are running on the workstation. Other processes will 
simply require more time in order to complete their operations. 

Conversely, if the RIP Priority Level is decreased, then print jobs will require more time to complete. 
Processing 

 
Tools menu >> Options >> Processing tab  
 

Concurrent Jobs 
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Though IColor ProRIP can spool a print job quickly, there is still time required to send the spool data to the 
printer (say over a network). In addition, the printer has a physical limit with respect to how quickly ink 
can be laid upon the media. 

Instead of waiting idle for a spool file to be completely received by the printer, IColor ProRIP can begin 
creating spool files for subsequent print jobs concurrently. However, please note that only one spool file is 
being compiled at any given time. The Maximum number of concurrent RIPs limits the number of spool 
files that can be compiled in advance of the job that is currently being spooled. 

 

Maximize Throughput 

By default, concurrent jobs are allowed in the same queue, and between different queues. However, turning 
OFF the Maximize Throughput option can be used to prevent multiple concurrent jobs within the same 
queue. 

 

1. ON (default) = Concurrent jobs allowed within the same queue, and between different queues 

2. OFF = Concurrent jobs not allowed within the same queue 
 

Preview Options 

By default, when a new job is received by the IColor ProRIP , its name is listed in the Active List of jobs, a 
thumbnail   image of the job is shown next to its name, and a thumbnail preview of the job is shown in 
the Visual Print Manager. Typically, these thumbnail previews are of medium quality, though the preview 
quality can be increased using the Preview Options. 

 

Generate thumbnail previews - Clearing this checkbox (OFF) will prevent thumbnail previews 
from being automatically created. However, previews can be manually created by right-clicking 
the given job and choosing Jobs menu >> Generate Preview Image. 

Preview quality - Adjusts the screen resolution of the generated preview. Higher quality will require the 
greatest amount of time in generating the preview. 

Gamma adjustment - Adjusts the relative brightness of the generated preview. 

Preview image bits per pixel - Limits the number of color shades that can be assigned to a given 
pixel. Choosing 1 bit per pixel will create preview colors that appear blotchy. 

Limit number of previews - By default, when multiple jobs are received at the same time, thumbnail 
previews will be methodically generated one-by-one. Use the slider to increase the number of 
previews that are generated in parallel. 

 

Print Direct to Port 

Tools menu >> Direct to Port  
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Note: This is a quick, specialized method of sending a print job in order to test that the computer port is 
communicating data to the printer.  
 

This tool will open a Send to port dialog in the top-left corner of the IColor ProRIP window. Image files can be 
drag-and- dropped onto this dialog to initiate a print job, and the job will bypass the queue and be sent 
directly to whichever printer is connected to that port, without any processing. As such, the print quality will 
be negligible, and the practical reason for using this tool is to confirm that data is being communicated to 
the printer. 

From the drop-list, choose the port where the print jobs will be sent. To the right of the drop-list, click the 
ellipsis button (three dots) to edit the port settings. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
How to Automatically Output a Job 

 
In addition to merely selecting a job, IColor ProRIP can be configured to perform automatic processing, 

including output of the given job. However, please note that the job must be “closed” before automatic 
scheduling will occur. 

1. Choose Queue menu >> Properties 

2. On the Layout Manager tab, set Close page on import = ON 

If the Media Setup tab has been configured for template media, then the Layout Manager option will 
be 

Automatically close template when all slots filled = ON 



 
112 

 

3. Under the Output Scheduling controls, choose the “on Barcode” option that you want to occur when 
the barcode is scanned. Note that the available “on Barcode” options vary according to the printer model. 
Per this screenshot, when you scan a barcode, the job will become selected, and the job will be rasterized, 
though it will be held before outputting the job data to the printer. 
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Manual Find of the Job Name 
 

Without using a barcode reader, you can find a job using a partial match of the job filename. 
 

1. In the toolbar, click the Find Job button. 

2. The Find Job dialog will open. 

3. The upper-half of the dialog is a simple find tool, as follows: 

a. Above the Find button is an edit field. Type a word that you know is part of the job 
filename that you are looking for. 

b. Click the Find button to select the first job that has your word in its filename. 
 

If you want the edit field (a) to be available from the toolbar, then set Show find job in toolbar = ON 

 

 

 
Layout Preview 

 
View menu >> View Layout Preview  

The Layout Preview is the right-hand side of the IColor ProRIP window, which previews jobs as they will be 
positioned upon the media. The bottom portion of this preview is the SmartBar, which provides context-
sensitive controls. The SmartBar is divided into three tabs: Queue, Page, and Job. 
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SmartBar Queue Tab 
 

As a whole, these controls apply to the current queue. 

 
A - Print Mode 
B - Pending Jobs 
C - Media 
D - Layer 
E - Easy color adjustments for ALL incoming jobs. 
 

SmartBar Page Tab 
 

Similar to the queue tab, these controls refer to the current page of material, which can contain one-or-
more job designs that will be sent as a single output job. 

If jobs are being paginated into separate sections of the media (i.e., Layout Mode = Auto Page), then 
the first job will be on sheet 1, the second job on sheet 2, etc. 

If jobs are being nested (i.e., Layout Mode = Auto Nest), then several jobs could be within sheet 1, 
more jobs within sheet 2, etc. 

Note: For nested jobs that have significant white space, using the [Ctrl] key when dragging will 
allow the jobs to overlap.  

 

 
F - Total times to output job. 
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SmartBar Job Tab 
 
As a whole, these controls apply to the current queue. 

 

G - Click twice to open the Step and Repeat dialog. 

H - Easy color adjustments for SELECTED job. 

 
 
 

Creating Copies 
 

When copies are created within IColor ProRIP , only the original selection will be rasterized, and the copies 
will reuse the rasterization data. In comparison, if multiple copies of a job are sent from the given design 
application, then all such copies will be rasterized individually (i.e., more processing time and overhead 
would be required). This feature is helpful when printing smaller graphics, such as chest logos on a T 
shirt, and you want to use as much of the media as possible in doing so. 

 

Create Copies of a Job 

Note: Use of the word ‘copies’ in this section does not relate to the number of times the page will be printed. 
Rather, it refers to how many of the same image (copies of the image) will be place on the same page.  
Another word for this would be ‘tiling’ or ‘ganging’ images. 
 

1. In the Layout Preview, select the job. 

2. Size and place the original image as desired on the page. 

3. Click the Copies button, and handles will appear to the right and bottom of the copies. 

4. Drag the handles to create copies. You can also use the tools available under the copies button for 
more precise placement and size. 

5. Alternatively, click the Copies button a second time, and the Modify Step and Repeat dialog will open. 
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Step and Repeat 
 

Step and Repeat is an extension of the Copies feature, where an original copy can be arranged into a 
variety of seamless tile patterns (with no white gaps between copies). As with the Copies feature, Step 
and Repeat will only need to process a single copy, which means that the RIP processing and output 
time will be dramatically more efficient than an equivalent large job (that did not use copies). 

To open the Step and Repeat dialog, do the following: 

1. Select a job, and the Job tab will become active within the SmartBar. 

2. On the Job tab, click the Copies button 

3. A single copy will appear, and basic controls for creating copies will appear in the SmartBar. 

4. Click the Copies button again, and the Modify Step and Repeat dialog will open. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Filling an Area 
 

Of note, the Area fill checkbox will toggle whether you want to 1) specify a total number of columns and 
rows (of copies), or 2) define the total area (length by width) that should be filled with copies. 

By default, copies will be clipped by both the edges of the media, and the Area fill that you have defined. 



 
117 

 

To force only non-clipped copies to be printed, then clear Generate Partial Items = OFF 

Pattern Style 
 

The choice of Pattern Style will determine how copies are staggered, where each row is offset by a fraction 
(Ratio) of the original copy size. For example, a Ratio of 1 / 4 will inset each row by 25% of the original copy 
width. 

 
By default, the spacing between copies is zero, which will create seamless tiles. However, white gaps can 

be added by adjusting the X and Y spacing fields, either as an absolute value, or as a percentage of the 
original copy size. 

 
 

Interlinking Patterns 
 

An interlinking pattern is created by using negative values for the X and Y spacing fields, which causes the 
copies to slightly overlap. However, when using negative spacing, ensure that the original copy has a 
white background, otherwise any background color will visibly overlap the graphic of adjoining copies. 

Here is a bad example of an interlinking pattern, where the yellow background clips adjacent copies: 
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Using the same dialog settings, there is no issue when the original copy has a white background: 
 

 
 

Tiling Jobs 
 

For a new print job, suppose that the Visual Print Manager shows a red highlight where the job exceeds the 
media bounds. 

 
Note: Use this feature when you want to crop a graphic within the RIP. 

 

1. Select the job and right click on the image preview. 

2. Select Create > Crop and right click.  
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3. The Tiling Setup dialog will open. 
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4. By default, the job will be shown with a tiling line that indicates where the job 

exceeds the media. Depending on the extent of the tiling requirements, additional 

tile lines will be created as necessary. 

 
5. Click the Manually option. 

6. Drag to reposition the tiling line, such that any seam from the tile line will be minimized. 

7. If necessary, click the Overlaps option and define the amount of extra artwork that will be printed per 
tile. 

Note: If the Print overlap lines checkbox is enabled, then a dashed line will be printed to 
indicate where the overlap begin 

8. If necessary, drag additional tile lines from the sides of the dialog preview. 
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9. Click the Create button to close the Tiling Setup dialog. 

10. The tiles will now be shown in the Visual Print Manager. 

11. To output the job, right-click the job in the active list and choose Print. 
 
Invert the Job 

 
The Invert button is a toggle that converts the selected job between positive and negative. When inverted, 

light areas will become dark, and vice versa. In color images, color reversal will also occur, with red areas 
becoming cyan, green areas becoming magenta, and blue areas becoming yellow. 

 

 

 

 
 

 

Easy Color Adjustments 

 
In the SmartBar, click the Color Adjust button to access simplified controls for adjusting the color settings. 

● For a selected job, click the Job tab (in the SmartBar), and then click Color Adjust. This will allow you 
to perform adjustments for the selected job. 

● For a selected queue, click the Queue tab (in the SmartBar), and then click the Color Adjust 
button. Your adjustments will be applied to all jobs that are recevied by that queue. 

 

 

Examples of a A) color positive image, B) color negative    
image, C) grayscale positive image, and D) grayscale 

negative image. 



 
122 

 

The Easy Color Adjustments Dialog 
 

When you first open the Easy Color Adjustments dialog, note that the Layers drop-list provides access to 
different layers that are defined within the Queue Properties dialog. 

 

● From the drop-list, the order of layers indicates the order in which they will be printed, such as 
Underbase layer before the Color layer. 

● The available controls will vary according to the type of layer that has been selected, and the 
controls can also depend upon how the Queue Properties dialog has been configured. For 
example, the following controls are typical when the Underbase layer is selected. 

 
CMYK Sliders : Per the individual channels, use the sliders to either decrease or increase the proportions of 

CMYK that will be output. 
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MaxInk Slider : The MaxInk setting will regulate the total volume of CMYK inks. For example, a MaxInk of 
200 will cause ink output to be regulated, such that the sum volume of the CMYK ink channels will not 
exceed 200. 

Brightness : Brightness will lighten or darken the entire job (i.e., will adjust the output colors equally). 
 
Saturation : Saturation will increase or decrease the vibrancy of the entire job (i.e., adjust the colorfulness). 

Chroma: Like Saturation, Chroma affects the vibrancy of the job, but its effect is more subtle. Chroma is 
applied as part of the ICC rendering, so that skin tones remain closer to their original hues. 

Merge : The Merge slider depends upon which option is active: 1) ICC Setting, 2) Photo, or 3) Graphics. See: 
Rendering Intent Override 

 
 

Rendering Intent Override 
 

Rendering intents for a queue are set via the Queue Properties >> ICC Profile tab. However, the 
rendering intent can be overridden, as follows: 

 

1) ICC Setting 
 

When the ICC Setting = ON, then the rendering intent settings will be used from Queue Properties > ICC 
Profile tab. 

 

2) Photo 
 

When Photo = ON, all of the ICC Profile tab settings will be overridden with the following: 

● First rendering intent = Relative (i.e., for graphics) 

● Second rendering intent = Perceptual (i.e., for photographs) 

● The Merge slider will default to 100, which means that Relative will be 0%, and Perceptual will be 
100%. 

● By moving the Merge slider towards the left, this will increase the relative (i.e., spot color 
accurate) color reproduction. 

Note: The Merge and Chroma sliders will only work with CMYK devices, not RGB or CMY 
devices. 

3) Graphics 
 

When Graphics = ON, all of the ICC Profile tab settings will be overridden with Absolute 
rendering intent. This has the benefit of providing the closest color match (good for spot 
color matching), but this will impair the quality of photographs.  
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Previewing Raw Print Data 
 

Print data can be examined on-screen prior to printing. This is typically done in order to confirm the print 
data that is available in each color channel. 

For example, suppose that a grayscale image needs to be printed, and the expectation is that only the 
black (K) channel will receive print data. This can be confirmed in the following manner: 

1. Click the Stop Queue button to pause the grayscale-only print job in the queue. 

2. Right-click the job and choose RIP Only. 

3. When the job has finished spooling, its Status will indicate "Holding [Job spooled]" 

4. Right-click the job and choose View RAW data. 

5. Click the Plane Select button. Each of the color channel checkboxes will be ticked. 

6. Untick the Black checkbox. 

7. The preview should now be blank because the CMY channels should not be receiving data for a 
grayscale-only job. 

Note: Colors appear differently on monitors than they appear when printed. As a result, the 
View Raw Data feature will not show colors on the screen exactly as they will appear when 
printed. 

 

Variable Dot Printers 

For printers that provide variable dot halftone support, note that a monitor display is not capable of 
previewing variable dot output because a monitor display contains only one size of pixel on-screen. 
Further, the limited number of monitor pixels may cause the preview to appear faded, though this fading 
will not be present in the actual print. 
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Controls for Previewing Print Data 

 

 

 

 

Save 

Select the Save button to save the picture as a bitmap image for comparisons or later viewing. 
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Print 

Select the Print button to print the preview. For example, the preview can be printed to a desktop printer 
for use as a sample. 

Zoom Tools 

Select Zoom In, Zoom Out, or select a Percent Zoom to view the image as a whole, or particular sections 
within the image. 

 

Color Planes 

Clicking the Planes Select button opens the Select Planes to View dialog. The color channels used to print 
the image will be listed. Unchecking color channels is useful as a means of confirming the inks that will be 
used when rendering the image. 

For example, suppose that a CMYK printer is being used to print a grayscale image using only the Black (K) 
channel: 

1. Click the Plane Select button. Each of the color channel checkboxes will be checked. 

2. Uncheck the Black checkbox. 

3. The preview should now be blank because the CMY channels are not being sent data. 
 

The Background color picker will indicate the media color. Alternatively, the color picker can be used to 
simulate different media colors. 

1. Click the Background color picker. 

2. Choose color that best matches the media color. 

3. Click OK to view the spool data on the new media color. 
 
 

Configuration 

Click the Configure button to open the Preview Configuration dialog. 

Treat Process as Spot - This option is typically off. However, when viewing color separations that are 
a combination of process and spot colors, setting this option = ON can help to obtain an improved 
view of the color blends. 

Show True Pixels Resolution - Many printers have different horizontal and vertical resolutions. 
The image that appears in the viewer is automatically adjusted to account for this, when Show 
true pixels resolution is unchecked. Checking Show true pixels resolution will show the image 
without this automatic adjustment, which will cause the image to appear stretched. 

Cache Size - If the viewer is drawing too slowly, and additional memory is available on the hard 
drive, then increase the size of the memory cache to increase the viewer speed. 
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Units - Select the units of measurement from the drop list (pixels, inches, or centimeters). The 
units of measurement appear in the bottom right corner of the View Raw Data dialog. 

 

Image Information 

Clicking the Image Info button will open an Image Info dialog. The dialog includes a list of information 
specific to the image including the printer, resolution, color planes, image size, and file location. 

 

View as Black 

Check the View as Black option to change the background color to white, and all other colors to black, within 
the image preview. 
 
Queue Properties 

A queue is a repository for print jobs, where jobs are collected (and inspected) before being sent as output 
to the given device. Often, multiple queues are created for a printer, so as to collect jobs for different 
media types (e.g., white garment material versus black garment material). From a designer’s point of 
view, a queue appears like a print destination, and printing a design will cause that design to be collected 
within the given queue. 

Beneath the main menu, a tab for each queue is available, and clicking the tab will display its contents (i.e., 
jobs in the Active List and on the Visual Print Manager). Queue properties are applied to jobs when they 
are received in the queue, and the queue properties can be edited in either of the following ways: 

Choose Queue menu >> Properties. 

In the Toolbar, click the Configure Queue button.  
Double-click the queue tab. 

 

Settings 

 
Layer-related Tabs 

For each distinct type of printer head pass operation (e.g., underbase pass, color pass, finish pass, etc.), 
there isL yer Profile Tab and several layer-related tabs that define the parameters that will be applied for 
that operation. For more information about layers, please refer toLayer Profile Tab. 

Note: There are also Advanced Queue Property tabs, though they are for specialized use and are 
only revealed via 

Tools menu >>Options >> General tab >> Show advanced settings and options 

Other 

General Tab 
 

Queue menu >> Properties >> General 

When the Queue Properties dialog opens, the default view will be that of the General tab. Further 
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controls are accessible through the other tabs that are arranged along the left-hand side of the dialog. 

The General tab displays the fundamental queue settings, such as the queue name, the type of printer for 
which jobs are being accumulated, and the print mode (i.e., media profile) that will be used when 
printing. 

 
 

Name - This is the print destination that this queue will appear as when users send a print job from their 
design application. 

Location - This is the explicit directory where job files are stored when being processed by the queue. 

Printer - The printer model for which this queue is accumulating jobs. The choice of print mode depends 
on the printer. To change the printer model, go Queue menu >> Manage Queues. 

Print Mode - This is the media profile that has been assigned to the queue. It is expected that the print 
mode corresponds to the loaded material or media.  

Substrate Color - This is the background color used in the Visual Print Manager, and it has no bearing 
on the printed output. Set this color according to the material color, so that you can preview job 
layouts on the expected color (e.g., set the color as black for black media). 

 

Queue Image 
 

When a job is selected, a thumbnail of that job will be displayed on the SmartBar Job tab. In a similar fashion, 
the Queue Image will be displayed when no job is selected. You can also specify a tooltip for the image. 

A queue image is a means of displaying a visual reminder that helps you to differentiate what queue that 
you are working with. The choice of image and/or tooltip is entirely dependent upon what is useful in 
your workflows. 
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Hot Folders Tab 
 

Queue menu >> Properties >> Hot Folders 

A Hot Folder is a specific directory that the queue will monitor for new design files. When a design file is placed 
in the hot folder, it will be automatically detected and added to the queue as a print job. 

Typically, a hot folder is used by other graphic designers on your computer network. They will copy their 
jobs into the Hot Folder, and your workstation queue will then be able to process those jobs. However, 
please note that other graphic designers will need the proper file access permission (as granted by your 
network administrator) to copy files into the hot folder. 

Note: If files are being downloaded from the Internet directly into the hot folder, then it is 
possible that a slow download rate will interfere with the hot folder process. As a solution, 
download the files to another directory location, and then move those files into the hot 
folder. 

Create a hot folder as follows: 

 

 

 

 

 

 

 

 

 

 

 

1. Click the checkbox for the type of hot folder. 
Enable queue hot folder - Create a standard hot folder that will add new print jobs according to 
the queue properties. 

Enable template hot folder - Create a template hot folder, where the layout of print jobs will be 
assigned according to a template that you have configured (see Media Setup Tab for more 
information about templates). 

2. A browse dialog will open. 

3. Choose a directory and click OK. 
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The directory must be initially empty, or it cannot be selected as a hot folder. 

In the case of a Template Hot Folder, a [template name] directory will be added to the queue directory. 
Likewise, sub- directories of ‘1’, ‘2’, ‘3’, and so on will be added, such that copying a design file into the 
given sub-directory will place the job in that slot location. 
 
Media Setup Tab 

 
Queue menu >> Properties >> Media Setup 

Use the Media Setup tab to specify the size and margins of the material that has been loaded into the 
printer. These settings will dictate the placement of jobs in the Layout Preview, such that you can visually 
confirm job layouts before committing to a print. 

Since multiple queues can be created for a given device, it can be useful to create a queue for each size 
that will be in frequent usage. 

 
Type - There are four classifications of media, two of which are common (roll and fixed sheet), and 

two that are special classifications (automatic sheet and templates). 

Roll media – Preview jobs according to a specific roll width. 

Fixed sheet media – Preview jobs in terms of a fixed page width and height. 

Templates – Use this setting when you have defined a template, which is a custom media type for 
arranging decals and similar volume batch production runs. 

Name - Once the type of media has been selected, this drop-list allows you to choose from the available 
sizes. In addition to predefined sizes, you can create custom settings using the Printer Media Manager 
dialog. 
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Creating a Custom Page Size 
 

Note: For certain printers, graphics are printed with respect to the center of the page. As 
such, creating custom page sizes on some printers can cause incorrect positioning of the 
graphics. 

Depending upon the printer model, the available printing area can be either a fixed page size, or a roll of 
material described as having a specific roll width. 

1. Choose Devices menu >> Manage 

Print Media. Alternatively, click [...] on 

the Media Setup tab. 

 
2. The Printer Media Manager dialog will open. 

 
3. From the Show media for drop-list, choose the printer that the page size applies to. 

4. Click the Add New Print Media button. 

5. In the Create New Media dialog, click the desired media type. 

For roll and sheet, the subsequent dialog will query for the dimensions and margins, and you 
must enter a name by which the "page size" will be referred to. 

For templates, please refer to the subsequent section, Creating a Page Layout Template. 
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Creating a Page Layout Template 
 

A page layout template is like a sheet of fixed media, except that there are one-or-more "slots" into which 
a received job will be slotted. 

● A template has an overall width and height. 

● Each slot has a width and height, plus a specific position within the template. 

● When a job is received, it will be scaled to fit the slot. 

● If there is more than one slot, then each slot will be filled with the received job. 

● There can be different slot sizes, and the job will be scaled to fit the given slot. 

● There are additional parameters that can be set for a slot, such rotation or alignment within the slot. 

● Slots have a numeric label, such as slot #1, slot #2, etc. For slots of the same numeric label, they 
will be filled    with the same job. For example, in the following screenshot, slots #1 will be filled 
with the first received job, and slots #2 will be filled with the next received job. 

 
Now, in continuing from step (5) of the previous section ( Creating a Custom Page Size ), the Create New 

Media dialog prompted you to choose the type of media. Suppose that you clicked the Create Template 
Media button: 

6. The Template Setup dialog will open. 
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7. In area (A), type a name for your template and specify its overall dimensions. 

8. In area (B), click the Add button, and specify the parameters of the given slot (i.e., size, initial 
placement, numeric label, etc.). 

9. Click the Save button to create your slot, and the first copy of the slot will appear in areas (C) and (D). 

10. In area (C), select the slot and copy it either down and/or to the right, thereby filling the template 
with duplicates of that slot. 
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Layout Manager Tab 
 

Queue menu >> Properties >> Layout Manager
  

 
Note: The available controls can vary according to the printer model, and whether Tools 
menu >> Options >> Show Advanced Settings is enabled. 

The Layout Manager tab controls how jobs are scheduled when received in the queue. In effect, these 
controls can force all jobs to be collected, so that the operator can confirm the job layouts before 
proceeding with a given print. 

If the queue is Stopped, then all jobs are automatically placed on Hold, regardless of the Output Scheduling 
settings. 

 

Layout jobs as they arrive 

ON - Enabling this checkbox causes received jobs to be placed in the Active List, and their layout is 
shown in the Visual Print Manager. 

OFF - Received jobs will be placed in the Reserved list. In such cases, the job needs to be manually 
moved to the Active List in order to print the job. 

 
 

Mirror job on import 

Reverse the job, such as for printing to clear transparent vinyl, where the vinyl will be applied to the window 
interior. 

 

Invert job on import 

Convert the job image into the equivalent of a photographic negative. 

● For a greyscale image, light areas will become dark, and vice versa. 

● For a color image, color reversal will occur, with red areas becoming cyan, green areas becoming 
magenta, and blue areas becoming yellow. 

 

Page Overlay 

If the "Process multiple page jobs as overlay" checkbox has been ticked, then the color layers within a job 
(i.e., CMYK and spot color layers) will remain "stacked," as opposed to being nested as separate jobs. 

 

Layout jobs right to left 

Alternate the starting edge from which jobs will be positioned within the Visual Print Manager. 
 

Show "Import Template Job" dialog 

This option is available when the Media Setup tab has been set for Template media. 
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The Import Template Job dialog will appear when a job is received, and you will be given a choice to 
either automatically place that job into the first available slot (Express), or manually choose the slot 
(Select). 

 
Remove Excess White Space 

Normally, if there is trailing white space for a print job, the print head will still perform the passes to 
"complete" the job, despite the absence of any ink (i.e., process white CMYK = no ink). For a design that was 
printed without noticing that the trailing white portion portion could have been cropped off, this option will 
prevent the print head from performing unnecessary passes. 

 
Output Scheduling 

 
When a job is received, indicate what automatic processing of that job should occur. 

The available options will depend upon the type of job, and the machine being used for output. 
 
Printer Status Tab 

 

Queue menu >> Properties >> Printer Status 

Displays the current printer status, and provides maintenance options according to the given printer 
model. Consult the printer operator manual for explanations about the available controls. 
 
Job Reserve Tab and Archiving 

 
Queue menu >> Properties >> Job Reserve 

From the main IColor ProRIP window, the Reserve List is a short list for your frequently printed jobs. Sending a 
print job involves compiling a PostScript file into a spool file, and then the spool file is sent to the printer. 
When a job has been completed, it can be added to the Reserve List as a PostScript and (optionally) spool file 
for reuse. 

Enable job reserve - When a job has completed printing, its PostScript file will be added to the Reserve 
List. 
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Save spool file on job reserve - Enabling this option will cause the compiled spool file to be reserved 
(i.e., avoid spending time compiling the PostScript into a spool file). 

 
 

Note: Where the spool file has been archived, re-sending the job does not require the time 
that was spent compiling the spool file (potentially several minutes, depending on the 
workstation and the complexity of the print).  

Note: A spool file requires comparatively much more hard drive space than the corresponding PostScript 
file.  

Archiving Jobs for Future Reuse 

In addition to reserving jobs for later use, jobs can be archived as a combined JBK file that contains both 
the job and log data, such that the JBK can be safety stored (i.e., backups) and then restored at a later 
date. Restoring jobs in this fashion eliminates time spent re-spooling a file, and avoids any "guess work" 
related to the job settings, etc. Archiving also preserves the log and notes related to the job, such that job 
specifics can be referenced. 

 

Setting the Archive Location 

The archive location is the directory where archived jobs will be stored. This needs to be a location that can 
be accessed later to restore the given job. 

1. Go Tools menu >> Options >> Storage and Archiving tab 

2. Near the bottom of the tab, the location for job archiving is indicated. 

3. To change the archive location, click the ellipsis button. 
Archiving a Job 

To archive a job, the job must be in either the Active List or Reserved List. 
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1. Select the job and then choose Jobs menu >> Archive to disk . 

2. The archived job will appear as a JBK file in the archive location. 
 
 

Loading an Archived Job 

Loaded jobs will be placed in the active queue. 

1. Click the queue tab to make it active. 

2. Go Jobs menu >> Restore Jobs. 

3. The Restore Job Tickets dialog will list the available archives. 

4. Select the desired archive and click the Restore Archive button. 
 
ICC Profile Tab 

 
Queue menu >> Properties >> ICC Profile 

Note: There will be an ICC Profile tab for each layer that has been defined (e.g., Color layer, 
Underbase layer, Finish layer, etc.). 

There is already an ICC Profile set for all printing modes and media settings. The following 
instruction is for adding an additional ICC Profile. 

 

 

 

An ICC profile provides a snapshot of the color gamut that a given input or output device is capable of 
rendering. 

● Input profiles typically represent the colors as seen when creating the design in a graphic design 
application. 

In order to produce the highest quality color reproduction, it is recommended that the input color 
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profiles (in IColor ProRIP) match the computer display that was used when creating the design. This 
can be done by using an industry standard input profile, or by using specialized equipment to profile 
the computer display. 

Note that there can be different input profiles according to the type of graphic objects (i.e., line art, 
bitmaps). Also, input profiles can vary according to the color space that was used to represent 
object colors (i.e., RGB, LAB, CMYK). 

● The output profile represents the colors that the printer is capable of reproducing, and this profile 
data is stored in the print mode. 

In order to produce the highest quality color reproduction, the output profile is ideally created for 
your specific printer, such that the various operating conditions are taken into account (e.g., media, 
inks, operating environment of the printer, etc.). 

 
Profile Sets 

 
On the ICC Profile tab, there are three line-art tags (RGB, LAB, CMYK), and three bitmap tags (RGB, LAB, CMYK). 
 

 
 

All six of these tags form a profile set, which is simply a convenient grouping of the input tags that you 

want to use. From the Select profile set to use drop-list, there is a selection of preconfigured profile 

sets, which are as follows: 

● Original : Reset any changes to the input profiles. 

● Enhanced : Use the enhanced input profiles provided by CADlink. These are the recommended 
choice of input profiles. 

● Get from print mode : Use the input profiles as indicated in the print mode. 

● Custom : Choose the individual input profiles. 
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Any additional profile sets are commonly-used industry standards that are beyond the scope of this 
documentation to describe. 

 

Overriding Output Profiles (Devicelinks Color Edits) 

You may override or add to the preset profiles, which would adjust CMYK settings such as contrast, lighten / 
darken your graphic, reduce / increase toner density and saturation. Devicelinks can be added to a queue, or 
an individual job. In cases where you wish to alter individual jobs: 

1) Right click on a job you have already imported 

2) Select ‘Properties’ 

3) Expand the ‘Color Layer’ tab and click ‘ICC Profile’ 

4) Check the ‘Override Output Profile’ box and then click the down arrow to the right of the current profile. 

5) You can add up to four Devicelinks. Devicelink 1 will usually be predetermined based on the media and 
queue currently set. You can either override that, or add to it. In this example, we will add a second 
Devicelink. Click the three dots and then ‘Select from Printer Profiles’.  
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6) Navigate to the ‘Devicelinks’ folder and make your selection. Files names makes it easy to determine 
what each does. For example, ‘Contrast 40pc’ will increase your contrast by 40%. Click ‘OK’ once selected 
to set the profile.  

 

 
 

Rendering Intent 
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For the colors that are in the job, the rendering intent determines how those colors will be mapped from 

the input profile (i.e., from the graphic design application), to the output profile (i.e., per the print mode 
for your printer). 

The rendering intent is actually a complex mathematical conversion, but you can choose the most 
appropriate rendering intent according to your job needs, including exceptions that you can define. 

 
 

 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Changing the Rendering Intent 

The rendering intent can be set for each of the six input tags (three line-art, three bitmap). 

At the far-right of the given input tag, click the inverted chevron button to view the rendering intents, and 
exceptions that can be applied. 
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The Merge Slider 

For the two drop-lists, the first rendering intent is chosen via the left-hand list, and the second rendering 
intent is chosen via the right-hand list. 

 

 
 

The Merge slider controls the amount of blending that will be performed between the first and second 
rendering intents. For example: 

● Merge = 50 : This will cause a 50:50 blend between the two rendering intents. 

● Merge = 0 : Only use the first rendering intent. Increasing the slider value will blend in more 
of the second rendering intent. 

● Merge = 100 : Only use the second rendering intent. Decreasing the slider value will blend in 
more of the first rendering intent. 

 

The Chroma Slider 

Chroma is similar to saturation in the HSB color model. Chroma does not affect grayscales, and it has a more 
visible effect when colors become stronger (i.e., more saturated). 

The Chroma slider can be used to increase or decrease the chroma in highly saturated colors by +20 to -20. 

Increasing the chroma will make colors look stronger (i.e., more vivid), and decreasing the chroma will make 
colors look weaker (i.e., closer to gray). 

 

Explanation of Rendering Intents 
 

Both lists are identical, except that the first list starts with Perceptual, Relative, Saturation, and Absolute. 
All four of these are of a fixed definition per the ICC Consortium. 

For Relative, Saturation, and Absolute, these three are completely fixed in how mapping is to be 
performed, so they cannot be blended with a second rendering intent. 

Perceptual can be blended, and please note that Perceptual is equivalent to Standard Compression. 
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Perceptual 

This intent is considered to produce more realistic images and photos than Absolute, Relative or Saturation 
mappings. 

Almost the entire gamut is mapped to the target gamut, such that the relationships between colors are 
maintained. Since the human eye is more sensitive to changes in color, rather than to specific color 
wavelengths, the resulting image will appear quite similar to the original. 

Though this reduces the dynamic range of the input gamut, smooth color transitions in the original image are 
maintained. 

Relative 

Colors that are not reproducible in the target gamut are replaced by an in-gamut equivalent, which 
attempts to preserve the lightness and hue of the original colors. 

Saturation 

The entire gamut of colors are scaled to the brightest possible saturation. The chroma is kept constant, though 
lightness values may be adjusted. 

 

Absolute 
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Colors that are not reproducible in the target gamut are simply replaced by their nearest in-gamut 
equivalents. Unfortunately, this technique can produce noticeable hue shifts. And potentially, several 
discrete colors may all be replaced by a single color, such that abrupt edges are produced in previously 
smooth regions of the image. 

 

Standard Compression 

This is equivalent to Perceptual, except that neutral tones are converted using Relative. 
 

Blackpoint Compression 

This is intended for input/output gamuts that are of a similar size, though it is not suitable for small gamuts. 
Blackpoint Compression is similar to Relative Colorimetric conversion with black point compensation, but 
with both better definition in highly saturated colors, and hue-accurate color rendering. 

 

Dynamic Compression 

This rendering intent is used where the input and output profiles have a significantly large dynamic and 
contrast range. For example, RGB-to-CMYK conversions. 

 

Absolute Compression 

This is equivalent to Absolute, except that the contrast range in the highlights and shadows are adapted in 
order to avoid loss of image definition. 

 

Minimum Compression 

This is Perceptual Rendering that applies additional compression to the black point, so that the maximum 
dynamic range is utilized without loss of details in the shadow regions. 

 

Minimum White Compression 

This is like Minimum Compression, except that the additional compression is applied to the white point, which 
achieves a close match between the input and output gamuts. 

This can be beneficial for cross media color appearance, color matching or printing on slightly 

different media. Also, this rendering intent can be regarded as close to absolute colorimetric 

rendering. 

 
Relative Colorimetric 

This is equivalent to Relative. 
 

Absolute Colorimetric 

This is equivalent to Absolute. 
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Influencing Rendering Intents with Exceptions 
 

When an exception is enabled, the activity of the rendering intent will be blocked for that aspect of the 
printed job. A typical usage would be to preserve certain qualities in the design when printed. 

There is no absolute rule as to when a given exception should be applied, since such applications are quite 
situational. Exceptions are akin to an artistic choice that constrains that rendering intents within specific 
regions of the printed job. 

● Duplex – This provides a quick method of enabling all of the primaries to print as their pure 
color values. This includes Gray, 100% Black, and the CMY Primaries. 

● Triplex – This is the same as Duplex, with the inclusion of the RGB Secondaries. 
● 100% Black – Print black ink with no CMY. This will affect only 100% black areas (not 99% or 

less). Printing 100% black is useful for small text because this will reduce bleed, thereby 
producing crisp text. 

● Gray – This will print pure gray using black ink only, including gradients. 

● 100% CMY and 100% RGB – Force 100% Black to print as pure CMY / RGB. 

● Max CMY / RGB – Increase saturation by printing the maximum CMY / RGB possible whilst 
retaining the expected hue. 

● Primaries and Secondaries – Force colors to print as pure color inks, including gradients, without 
black ink. 

● Black Overprint – Same as 100% Black, except minimize any CMY adjustments at the same time 
(CMYK designs only). 

● Border Clipping – (CMYK input designs only) Clip any channel that will be firing close to 0% or 100%. 

● White – Used with Absolute rendering intent. Ensure that white is always printed with no ink, 
otherwise there will normally be some ink that matches the white on input). 

● 400% Black – (CMYK input designs only) Print 100% Black as 400% Black. 

● Preserve 0% black – (CMYK input designs only) Where K = 0 in the design, ensure that K remains 
zero when printed (i.e., do not perform substitutions of K for equal portions of CMY). 

● Range – This is the tolerance within which an input color value will qualify for a given exception. 
Increasing this tolerance will cause more colors to be affected by exceptions, and vice versa. 
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Advanced Queue Properties 

For IColor ProRIP , these tabs are considered to be less frequently needed, and are hidden to reduce the 
complexity of the user interface. However, these tabs can be revealed via Tools menu >> Options >> 
General tab >> Show advanced settings and options. 

 
CMYK Color Adjustments Tab 

Queue menu >> Properties >> CMYK Color Adjustments                                                                                      
Note: The Processing Options Tab also has some CMYK Color Adjustment controls.                                                  
Note: These are advanced tab controls that are hidden by default. To reveal these controls, tick 
the Tools menu >> 

Options >> Show advanced settings checkbox. 

Note: There will be a CMYK Color Adjustments tab for each layer that has been defined (e.g., 
Color layer, Underbase layer, Finish layer, etc.). 

The Color Adjustments tab adjusts the color levels of the print job. These adjustments are not typically 
required because the ICC profile is created for use with a specific calibration. As such, performing color 
adjustments will actually distort the color accuracy of the ICC profile. 

One reason for color adjustments would be to create an artistic effect. However, the main reason for color 
adjustments is to compensate for non-standard media and inks, where the cost of producing a new ICC 
profile is prohibitive. Making color adjustments by eye is neither quick nor easy, especially when 
adjusting the curve of individual color planes. Unless very experienced in color theory, the wisest advice 
is to keep any changes simple. For example, if adjustments were made to Shadows for Cyan, Highlights 
for Magenta, and Midtones for 
Yellow, all without checking the 
results of each    step, then there 
would be confusion over which 
adjustment caused a given effect. 
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Tonal Correction 

 
Apply tonal correction first by adjusting all the colors together (using the same curve for all CMYK color 

planes). 

Use the Shadows, Midtones, and Highlights sliders to lighten or darken the image (higher values to 
lighten, and lower values to darken). 

The easiest way to adjust the tonal range is to adjust the highlights first, then the shadows, and lastly 

the midtones. Once the midtones are correct, the highlights and shadows can be further tuned. 

 

 

Printing a Test Page 

Devices menu >> Print test page 

All adjustments should be checked by using the CADlink test page, which is specifically designed to help 
recognize changes due to tonal adjustments. For example, the individual tints can be checked by 
referring to the tint percentage boxes, whereas the overall balance is checked by looking at the color 
graduation. 

Note: When the test page looks correct, perform an additional test using a photographic image.
  

 
If the 5% tint box appears to be empty and the 10% tint box appears too light, then reduce the white 

point (Highlights slider) by ten. If after another test these tint boxes appear too dark, then 
incrementally raise the white point and continue printing test pages. 

Similarly, if the 90% to 100% tints are too dark, then increase the dark point (Shadows slider) by ten. 
If after another test these tint boxes appear too light, then incrementally reduce the black point. 

 
 

The Shadows Slider 
 

The Shadows slider adjusts the black point, 
which is the lower end of the curve. 
Increasing the Shadows value causes the 
darkest parts of the print to be 
recognized as pure black, which also 
causes the darkest details to be lost in 
the shadows. 

Generally, the purity of printed black 
depends on many factors, such as how 
many colors are being used. Use the 
mouse to adjust the Shadows slider. 
 
The Midtones Slider 
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The Midtones slider adjusts the gamma curve, which affects the midtones without changing the black and 

white points (the lower and upper ends of the curve, respectively). Raising the midtone of a color plane 
results in laying down less ink on the media for that color. Use the mouse to adjust the Midtones slider. 

 

 
The Highlights Slider 

 
The Highlights slider adjusts the white point, which is the upper end of the curve. Lowering the Highlights 

value causes the lightest parts of the print to be recognized as pure white, which causes the lightest details 
to be lost in the highlights. 
 

Use the mouse to adjust the Highlights slider. 

 
When both Highlights and Shadows are adjusted, the contrast between light and dark areas will be more 
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pronounced. However, light and dark details will be lost as those tones were forced to either 0% or 100%. 
 

The Highlights and Shadows controls are useful for preserving details on printers that are incapable of 
differentiating the darkest and lightest pixels accurately. By adjusting the white and black point values, 
more of the image details will fall   within the range that the printer is capable of rendering. 

 
 

Density Curve 
 

The Density Curve is used to set densitometer values for each color plane. This curve is similar to using the X-
Rite colorimeter, though lower-cost hand held devices may instead be used, and the data must be entered 
manually. 

 
 
 
 
Separation Curves Tab 
 
Removing a Color Cast 

A color cast is a visual imperfection that is usually caused by a dominant ink (or set of inks). Depending on 
the complexity of the imperfection, the solution will be either simple or complex. 

 

Simple Solution 

In the simple case, removing a color cast is possible by adjusting the tonal settings of the individual colors 
that are causing the cast. Begin by adjusting the overall tonal balance. The color balance may then be 
adjusted using the Midtones  slider  for each offending color individually. 
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Note: As previously mentioned, use Print test page ( Devices menu) after each adjustment. 
When all adjustments appear complete, perform a final test by printing a photographic 
image. 

 

 
Complex Solution 

Where a complex color cast must be removed, the primary consideration is that each adjustment will affect 
the overall   color balance of the image. Decreasing one color (say Magenta) will increase its opposite 
color on the color wheel (Green). 

 
The effect occurs because Green is composed of both Yellow and Cyan. Reducing Magenta effectively increases 

the proportions of Yellow and Cyan (relative to the previous CMY proportions). Effectively, the image will 
appear greener. 

Before solving this problem, note that the choice of color model is not significant. However, the 
recommendation is to choose the same color model used by the output device. 

The first step is to identify the color(s) that are causing the problems. This is a personal talent that develops 
with experience, so continue to practice. The Print test page (Devices menu) is a useful starting tool 
when identifying problems with color. All the necessary ingredients for judging color reproduction are 
contained in this file. Analyzing the hue wheel (printed as a 1" border), will reveal any bias towards a 
particular color. 

The CMY (composite black) graduation will give the best indication of how well the CMY inks are balanced. 
Film Recorders usually produce a pure grayscale, whereas standard color reference systems (SWOP, 
PANTONE, EuroScale, etc.) produce a gray that has an acute Magenta tinge. 

Note: If the desired output will ultimately be rendered on an Offset Press, then it may be 
preferable to reproduce the Magenta tinge. 

 

Once the problem colors are identified, the alternatives are: 

1. Raise the midtone value of the problem color, which will result in a less saturated print. 
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2. Lower the midtone values of the non-problem colors, which will result in a more saturated print. 

3. Combine alternatives (1) and (2) by raising the midtone value of the offending color, while 
also lowering the midtone values of the other colors. 

 

 

Further Solutions 

When working with color models, though the chosen model may be CMYK, Green may still be adjusted by 
modifying Magenta (which is the complement of Green in the color wheel). For example, increasing the 
amount of Magenta will reduce the green in the final print. 

Where one color is dominant, such as an overall Yellow tinge to the whole page, the solution may be to 
reduce the Shadows slider for Yellow. This will reduce all areas of the page that have a large percentage 
of Yellow (90% - 100%), which will therefore have an immediate effect. 

Note: A color swatch from one of the standard reference systems (SWOP, PANTONE®, 
EuroScale, etc.) is an invaluable aid in the process of color correction, and well worth the 
investment. Using a color swatch will show exactly what the end result should be, allowing a 
direct comparison with the tints and graduations using Devices menu >> Print test page. 

Variable Dot Setup Tab 

Queue menu >> Properties >> Variable Dot SetupNote: These are advanced tab controls 
that are hidden by default. To reveal these controls, tick the Tools menu >> 

Options >> Show advanced settings checkbox.
  

Note: There will be a Layer Profile tab for each layer that has been defined (e.g., Color 
layer, Underbase layer, Finish layer, etc.). 

The Variable Dot Setup provides exacting control over small, medium and large dot usage on variable dot 
printers. This provides the ability to set the thresholds for how dot sizes transition throughout the print. 
However, adjusting these thresholds will typically require that the ICC profile be recreated for the given 
printer model. 

 
 
Performance Tab 

 
Queue menu >> Properties >> Performance 

 
Note: These are advanced tab controls that are hidden by default. To reveal these controls, 
tick the Tools menu >> 

Options >> Show advanced settings checkbox. 

 
Sending a print job involves processing the job into a spool file, and then the spool file is sent to the printer. 

The choice of print mode determines the RIP resolution at which the job is processed. High resolution print 
modes tend to produce higher quality prints, though this requires more time to process and spool jobs. So 
to reduce printing time, it is common practice to simply choose a lower resolution print mode. 
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As an alternative to manually using a low resolution print mode with certain jobs, the Performance tab can 
be used to automatically reduce the RIP resolution according to the job complexity. For example, with 
simple line art or text that has been scaled up to fill a large banner, IColor ProRIP can determine that the 
maximum RIP resolution is not necessary in order to retain print quality. 

 
 

Resolution Reduction 

 
 

Use Intelligent Resolution Reduction 

If this checkbox is ticked (ON), then IColor ProRIP will perform calculations for each job to determine 
whether a lower RIP resolution can be used. 

For jobs that would suffer at lower resolution, they will be processed at the resolution that is set 
within the print mode. 

 
 

Resolution Reduction Slider 

If the checkbox is clear (OFF), then the Resolution Reduction slider will become active. 

This slider provides a manual means of adjusting the relative amount of resolution reduction that will be 
applied. 

If the slider is set to the far-right (i.e., Best Quality), then jobs will always be processed at the 
maximum RIP resolution (per the print mode). In other words, with the slider set to Best Quality, 
no resolution reduction will occur. 

If the slider is set to the far-left (i.e., Fastest), then jobs will be processed at the bare minimum RIP 
resolution of 72 dpi. This can be suitable for jobs that are composed of simple line art or text, though 
detailed jobs can potentially appear blotchy. 

Generally, manual adjustment of the slider (between Fastest and Best Quality) requires finding a 
happy medium. This will rely upon evaluating small printed samples at varying slider positions. For 
example, if batches of jobs are expected to have a certain level of detail, then perform small tests 
(at varying slider positions) to determine the most efficient setting for those jobs. 

 
 

Use Interpolation 
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This option applies to imported bitmap formats, such as BMP, JPEG, TIFF, PSD, etc. Before a job is rasterized, 
the image data will be resampled to add anti-aliasing pixels, which will improve the perceived output quality.  

Note: This feature would not be desirable when printing separations. 

 
Enhanced Image Quality 

Enable this option to extend the Use Interpolation option to include PDF and EPS files. 

 

Copyright Notice 

PANTONE® Colors displayed in the software application or in the user documentation may not match 
PANTONE- identified standards. Consult current PANTONE Color Publications for accurate color. PANTONE® 
and other Pantone, Inc. trademarks are the property of Pantone, Inc., 2017. 

Pantone, Inc. is the copyright owner of color data and/or software which are licensed to CADlink 
Technology Corp. to distribute for use only in combination with CADlink products. PANTONE Color Data 
and/or Software shall not be copied onto another disk or into memory unless as part of the execution of 
SignLab and/or Production Spooler. 

No part of this publication may be reproduced mechanically or electronically or in any form without the 
prior written permission of CADlink. The software described in this online help is furnished under license 
and may only be used or copied in accordance with the terms of such license. The information in this 
help is for informational use only, is subject to change without notice and should not be construed as a 
commitment by CADlink. CADlink assumes no responsibility or liability for any errors or inaccuracies that 
may appear in this document. IColor ProRIP®, Visual Print Manager®, Visual Production Manager®, 
SignLab®, and Production Spooler®, are registered trademarks of CADlink Technology Corporation. 

 
 
 
 
 
 
 
 
 
 
 
For further information and tech support, please visit the support page at www.icolorprint.com/support 

 
Ask your dealer about all of our media options to help grow your business and keep you competitive: 

 
• IColor Premium and Premium Stretch 2-Step Transfer Paper for light and dark colored garments 

• IColor Select and Select Ultra Bright 2-Step Transfer Paper for light and dark colored garments 

• IColor Standard 2-Step Transfer Paper for light and dark colored garments 

• IColor Glitter Adhesive 2-Step Transfer Paper (for use with IColor Standard 2-Step Transfer Paper) 
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• IColor Light and Speed Trans Light 1-Step Transfer Paper for light colored garments 

• IColor Presto 2-Step Transfer Paper for textiles and hard surfaces 

• IColor Temporary Tattoo 2-Step Transfer Paper 

• IColor Classic, Premium, Wood and Leather and Ceramic Hard Surface 1-Step Transfer Paper  

• IColor AquaClear 1-Step Transfer Paper for candles and other substrates not resistant to heat 

• IColor Label / Sticker Paper (Clear and White) in Letter and Tabloid size  

• IColor Window Cling Media (Clear and White) in Banner and cut sheet options 

• IColor Banner Paper 

• IColor Magnetic Media in Letter and Tabloid size 
 
…and more! Contact your dealer for more information. 
 
Also available: 

 
IColor SmartCUT Software 
Easily print oversized images on letter/A4 sized printers with Uninet’s optional IColor 
SmartCUT software. Use any oversized graphic, and the software will split it in half along the 
most logical path. You can choose to have it split along dark or light areas, depending on the 
color garment you will be pressing onto. With this software, you can make 3XL shirts that 
are not possible with even the most expensive of printing systems because you can gang up 
as many transfer sheets as you want. For use with IColor Standard and Select 2-Step 
Transfer Paper. Trial version available at https://www.icolorprint.com/support 

https://www.icolorprint.com/support
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